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SECTION 1   GENERAL

Figure 1-1   Typical Portable Programming Setup

Figure 1-2   Mobile Programming Setup
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1.1 SCOPE OF MANUAL

This is an addendum updates the main PCCon-
figure programming manual with information required 
to program Ascend radios for Multi-Net operation. 
Both this manual and the main PCConfigure manual 
are included on the PCConfigure CD-ROM. Use this 
addendum to program Multi-Net operation and the 
main manual to program the other modes.

1.2 PROGRAMMING SETUP

To program the various transceivers, a 
Windows®-based computer, EFJohnson 
PCConfigure™ programming software, Part No. 
023-9998-488, and the following items are required to 

program the various transceivers. The portable 
programming setup is shown in Figure 1-2, and the 
mobile setup is shown in Figure 1-1.

5100, 51SL, and Ascend Portable

• Programming cable from computer to transceiver, 
Part No. 023-5100-920. NOTE: This cable, the -488 
programming software, and the PDF file for this 
manual are included in Programming Kit, Part No. 
250-5100-003.

No RPI is required to connect this radio to the 
computer because the radio contains the interface 
circuitry. The above programming cable has a female 
DB9 connector for connecting to the computer. 
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5300, 53SL, and Ascend Mobile

• Programming cable from RPI to transceiver, Part 
No. 023-5300-005. 

• Remote Programming Interface (RPI), Part No. 
023-5300-000. NOTE: The -005 cable, 5300-000 
RPI, -488 programming software, and the PDF file 
for this manual are included in 5300 Programming 
Kit, Part No. 250-5000-004.

Only RPI, Part No. 023-5300-000, can be used. 
Other RPIs such as 023-9800-000 and 023-9750-000 
are not compatible with these transceivers. 

The Radio Programming Interface (RPI) provides 
the required logic interface between the computer and 
transceiver. The cable from the RPI to computer is not 
included with the RPI or in the programming kit. The 
current RPI’s have a female DB9 connector, and most 
computer serial ports have a male DB9 or DB25 
connector. Therefore, a male DB9 to female DB9 or 
DB25 cable is usually required. This is a standard cable 
available at most computer supply stores or order 6 ft. 
DB9M to DB9F cable, Part No. 597-5900-002. 

The cable from the RPI to the transceiver is not 
included with the RPI, but it is included with the 
programming kits or can be ordered separately as 
previously described. 

This cable plugs into the microphone jack of stan-
dard front or remote mount transceivers. With trans-
ceivers using the Handheld Control Unit (HHC), the 
connection point is the 10-pin programming jack on 
the HHC junction box using a special adapter plug 
(Part No. 023-5300-140). If the HHC is not equipped 
with the junction box (Part No.023-5300-130), it is 
also required for programming. 

1.3 COMPUTER REQUIREMENTS

The computer used to run this program must meet 
the following minimum requirements:

• Windows® 95/98/NT/2000/XP (Windows 3.1 
cannot be used)

• Pentium® processor or equivalent
• At least 16 MB of RAM

• A hard disk drive with at least 4 MB of free space
• A CD-ROM drive
• An available serial port

1.4 OPERATING AND SERVICE MANUALS

This manual includes brief descriptions of the 
Multi-Net programming parameters. For detailed radio 
operating information, refer to the Ascend Mobile 
Operating Manual CD, Part No. 002-5580-001CD, or 
to the Ascend Portable Operating Manual CD, Part 
No. 002-5584-1000CD.

1.5 SOFTWARE VERSIONS REQUIRED

PCConfigure, Version 1.24.0 or later, is required 
to program the Multi-Net operating mode. In addition, 
the radio must be the Ascend version, Part No. 
242-558x-xxx or 242-538x-xxx. The 5100/51SL and 
5300/53SL versions cannot be programmed for 
Multi-Net operation. 

NOTE: Currently, the Ascend portable cannot be 
programmed for P25 trunked operation because of 
memory limitations. P25 trunked operation is avail-
able with Ascend mobile radios. Currently, all Ascend 
models are the SEM version (use Version 2.x 
firmware). 

1.6 SOFTWARE INSTALLATION

The PCConfigure software is supplied on a 
CD-ROM. Install this software as follows:

1. Make sure that there are no other applications open 
during this installation procedure. Also, make sure 
that the computer meets the minimum requirements 
listed in the preceding section.

2. Insert the PCConfigure CD-ROM in the CD drive of 
your computer.

3. In the lower left corner of the screen, select Start > 
Run and then click the Browse button. Select the 
CD-ROM drive and the file “PCConfigurex_x.exe” 
(x_x is the PCConfigure version number). Click the 
Open button and then from the Run window, click 
OK and the installation process begins. 



GENERAL

6

Figure 1-3   Main Screen (Global Screen Shown)
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4. Follow the on-screen instructions. The default 
directory for the program is \Program Files\EF 
Johnson\PCConfigure. This directory can be 
changed during installation if desired.

NOTE: Before completely removing an old version of 
PCConfigure, be sure to transfer the files in the Data 
and Keys folders to those folders of the new version. 

1.7 STARTING AND EXITING

To Start PCConfigure

To start the PCConfigure program from 
Windows, select Start > Programs > EF Johnson > 
PCConfigure 1.2x.xx. 

The PCConfigure program can also be started 
from an MS-DOS command prompt (C:\). To display 
the PCConfigure options that can be selected from the 
command prompt line, enter PCConfigure /?. The 
following information is then displayed.

To Exit PCConfigure:

Select File > Exit or press ALT and F4.

1.8 PROGRAMMING FILE TYPES

Programming data is stored in a disk file that can 
be saved, read, copied, and deleted (see Section 3.1). 
This file is automatically given the extension “.rcf” by 
the program.

1.9 HELP FILES

To display help information on the current screen, 
click Help in the menu bar.

NOTE: The ReleaseNotes.txt file lists the changes 
made with the various releases of the PCConfigure 
software. This file is located in the PCConfigure 
program folder. The default location of this folder is 
Program Files\EFJohnson\PCConfigure.
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1.10 MAIN SCREENS

Four different screens can be selected by clicking 
the tabs at the top as shown in Figure 1-3. The func-
tions of these screens are as follows:

Global - This screen is shown in Figure 1-3, and it 
programs parameters that are the same for all system 
types. Refer to Section 4 for more information on 
parameters in this screen.

Radio Wide - This screen programs the parameters 
that are the same for all programmed Multi-Net 
systems. The screen system type is selected in the 
System Specific box. Refer to Section 5 for more 
information on parameters in this screen.

Per System - This screen programs the parameters 
that are unique to each programmed Multi-Net system. 
The system to be edited is selected by clicking it in the 
Systems box. Refer to Section 7.1 for more informa-
tion on parameters in this screen.

Zone - This screen programs the channels and zones. 
Unique channel parameters include system and talk 
group encode/decode IDs. Refer to Section 7.2 for 
more information on parameters in this screen.

1.11 OTHER SCREEN INFORMATION

1.11.1  PROGRAMMABLE TITLE AND LOGO

The title that is displayed after “Radio Configura-
tion” at the top of the screen (see Figure 1-3) is 
programmable using the Tools > Organization Iden-
tity menu item. This can be used, for example, to 
display a company name on the top line. In addition, 
the logo that is displayed on the right end of the menu 
bar can be customized. Refer to Section 3.4 for more 
information.

1.11.2  ORGANIZER

Clicking the organizer button  on the right 
end of the toolbar opens and closes a screen that is 
used to organize the various programming files into 
groups and subgroups. This can make administrating 
the programming files of a large organization easier. 
Refer to Section 3.8 for more information.

1.11.3  FILE SIZE INDICATION

The maximum number of channels that can be 
programmed may be limited by the available memory 
space in the radio. A running indication of the amount 
of memory used by the current data if it was down-
loaded to the radio is displayed as a percentage in the 
“Size:” box in the status bar on the bottom of the 
screen (see Figure 1-3). When this percentage reaches 
100%, the available memory is full and some channels 
may need to be deleted if more information remains to 
be programmed.

1.11.4  DECIMAL/HEXADECIMAL SELECT

On some screens, such as the SMARTNET Talk 
Group, numbers can be entered using either a Decimal 
or Hexadecimal format. The format is selected 
globally which means that when a format is selected, it 
is selected for applicable numbers on all screens. 

The currently selected format is indicated in the 
status bar on the bottom of the screen in the box next 
to the file size indication (see Figure 1-3). A “D” indi-
cates the Decimal format is selected and an “H” indi-
cates the hexadecimal format is selected. In addition, 
the background color is ivory for all numbers which 
must be entered in Hexadecimal, and white for 
Decimal and other entries. 

To toggle between the Decimal and Hexadecimal 
formats, right click the H/D box and click Yes in the 
confirmation box that is displayed. This mode can also 
be toggled using the Tools > Preferences screen 
described in Section 3.4.

1.12 CREATING SYSTEMS

NOTE: To view the current and added systems, select 
the “Per System” tab and all programmed systems are 
displayed in the “Systems” pane on the left side.

A Multi-Net system as used with this radio 
programs the parameters for a single home repeater of 
all the sites into which a radio will roam. Unique 
system parameters include such things as home 
repeater number, emergency Zone/Channel, group 
scan list, individual (unique) ID, and fixed priority, 
transmit inhibit, and block IDs. Up to sixteen systems 
can be created.
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To create a new Multi-Net system, select Radio > 
Add Systems in the menu bar and then select the 
Multi-Net system type (see Section 3.2). Alternatively, 
click  in the toolbar and select the desired system 
type from the drop down list. The current systems are 
indicated in the “Per System” screen in the “Systems” 
box. To delete a system, select it in the “Systems” box 
and then select the Radio > Delete System in the menu 
bar or  in the toolbar.

NOTE: Project 25 operation is currently not available 
with Ascend portables only (see Section 1.5).

1.13 HOW TO PROGRAM SCANNING

1.13.1  GENERAL

The two types of Multi-Net scanning that can be 
programmed are Radio Wide and Group (Standard). 
Generally, these scanning types are utilized as follows: 

Radio Wide Scan - This type is usually programmed 
when two or more types of channels must be scanned 
at the same time such as conventional and Multi-Net, 
or if two or more Multi-Net systems (home channels) 
need to be scanned. If this is not a requirement, use the 
more efficient Group Scan which follows because 
there is less chance of missed calls. 

Group (Standard) Scan - The Multi-Net group scan 
feature monitors the Multi-Net groups in the scan list 
of the selected system (home channel). This list can 
include up to 32 channels (groups) linked to that 
system. This type of scan monitors only channels that 
are the same type as the selected channel. 

1.13.2  PROGRAMMING THE RADIO WIDE 
SCAN MODE

1. On the Radio Wide screen, program the Radio Wide 
Scan List and Scan Hold time as described in 

Section 5.2. The channels to be included in the scan 
list must have been set up as described in Section 6.

2. Program the Radio Wide Scan option button by 
clicking the Assign Buttons button on the Radio 
Wide screen as described in Section . With 51xx 
portables, a Radio Wide Scan menu parameter can 
also be programmed as described in Section 5.3. 

1.13.3  PROGRAMMING THE GROUP SCAN 
MODE

Group scan is set up on the Per System and Radio 
Wide screens. Proceed as follows:

1. On the Per System screen, select the desired system 
in the left pane. 

2. In the System Lists drop down list near the bottom 
of the screen, select “Group Scan List”. Then click 
the Edit List button and program the scan list as 
described in Section 7.1. The channels (groups) to 
be included in the scan list must have been set up as 
described in Section 6.

3. Repeat the preceding step for each system that will 
have Group Scan function.

4. On the Radio Wide screen, select Multi-Net in the 
left pane and program the Scan Delay Timers as 
described in Section 5.3. 

5. Also on the Radio Wide screen, program the Scan 
option button by clicking the Assign Buttons button. 
With 51xx portables, a Scan menu parameter can 
also be programmed. Refer to Section 5.3 for more 
information.
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SECTION 2   PROGRAMMING PROCEDURE

The following is a general procedure that can be 
followed to program a transceiver.

2.1 PRELIMINARY

1. Select a programming file as follows:

Create a New File - To start with a new file 
containing default parameters, select File > New and 
then when the dialog box appears, select the frequency 
band of the radio (currently, Multi-Net operation is 
available only with 800 MHz models). 

Open An Existing File - To open an existing file 
stored on disk, select File > Open and then the file 
name to be opened.

Read a File From a Radio - To transfer a file from a 
radio to the computer for editing or use as a basis to 
program another radio, connect the radio to the 
computer as described in Section 1.2. Then turn the 
radio on and select Transfer > Read Parameters From 
Radio in the menu bar. Encryption parameters cannot 
be uploaded for security reasons. Refer to Section 3.3 
for more information.

2. Be sure the correct radio type is selected by the 
Radio > Series menu (see Section 3.2).

NOTE: Some operating protocols and options may not 
be available with your radio. To display the options 
that have been factory enabled, select Transfer > Read 
Options From Radio (see Section 3.3).

2.2 CREATING SYSTEMS

A conventional system is automatically set up 
when a new programming file is created. Create a 
Multi-Net system by selecting Radio > Add System or 

 in the toolbar as described in Section 1.12.

2.3 ENTERING GLOBAL PARAMETERS

1. Display the Global Parameter screen by clicking the 
Global tab at the top of the screen.

2. Program the applicable parameters in this screen as 
described in Section 4. Parameters that do not apply 
to the selected Radio Series are grayed out.

2.4 ENTERING RADIO WIDE PARAMETERS

1. Display the Radio Wide screen by clicking the 
Radio Wide tab at the top of the screen. 

2. Program the applicable parameters Multi-Net 
systems as described in Section 5. This includes the 
Phone and Unit call and Status lists if applicable.

NOTE: The Radio Wide Scan List cannot be 
programmed until the channels are set up as described 
in the next section.

2.5 SETTING UP ZONES AND CHANNELS 

1. Display the Zone screen by clicking the Zone tab at 
the top of the screen. 

2. Set up Zones and Channels as described in 
Section 6. Zones can include up to 16 channels of 
any type.

2.6 ENTERING MULTI-NET SYSTEM AND 
CHANNEL PARAMETERS

1. Display the system programming screen by clicking 
the Per System tab at the top of the screen. 

2. Program the applicable parameters for each Multi-
Net system as described in Section 7.1. NOTE: It 
may be necessary to further define the channels as 
described in the next steps before programming the 
group scan lists.

3. Display the Zone screen by clicking the Zone tab at 
the top of the screen. Program the individual 
channel information of each Multi-Net channel in 
each zone as described in Section 7.2. 

4. If necessary, program the group scan lists in each 
system (see preceding step 2). After all channel 
information is programmed, program the Radio 
Wide scan list in the Radio Wide screen (see
Section 2.4).
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2.7 PROGRAMMING RADIO (WRITING FILE)

When all the required programming information 
has been entered in the various programming screens, 
the information can be written (downloaded) into the 
radio. When writing a file, be sure that all connections 
between the computer and radio are secure, the radio is 
turned on, and the proper serial port is selected (see 
Section 3.3). Then proceed as follows:

1. Select Transfer > Write Parameters To Radio from 
the menu bar.

2. If the radio has been programmed with a download 
password, it must be entered before data can be 
downloaded (see Section 8).

3. If no file is currently loaded, a dialog box appears to 
select the desired file. Otherwise, the current file is 
transferred to the radio. 

NOTE: The information which follows (Sections 3-7) 
provides detailed descriptions of the parameters in the 
various screens that are displayed by the 
PCConfigure program.
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SECTION 3   MENUS, TOOLBAR, AND STATUS BAR

3.1 FILE MENU

New - Creates a new programming file named
“Untitled.rcf” containing default parameters and 
displays a dialog box for selecting the frequency 
range.

Open - Opens a programming file that was previously 
saved to disk. If a modified file is currently open, you 
are asked if that file should be saved before the new 
file is opened.

Save - Saves the current file to disk using the current 
file name. If it is the first time a New file is being 
saved, the following Save As screen is displayed to 
specify the file name and destination. 

NOTE: Is is not possible to save any type of program-
ming file to disk without a radio connected. Refer to 
Section 9 for more information.

Save As - Saves the current file to disk and displays a 
screen for changing file name and destination if 
desired. The default file name is the P25 unit ID in the 
format “UnitID_xx”.

Close - Closes the current file without exiting the 
program so that another file can be opened or created 
if desired. If the current file has been modified and the 
changes have not been saved, you are asked if the 
changes should be saved before closing.

Send to Selected Organizer Group - Adds the 
current file to the group that is selected in the 
Organizer. Refer to Section 3.8 for more information.

Print - Prints the information in the current file. A 
screen is displayed to select if Global, Radio Wide, Per 
System, and/or Zone information is printed.

Convert Band - This function is used to convert UHF 
files from one band to another (the band is selected 
when it is created by File > New). It can also be used 
to convert an 800 MHz file to 700/800 MHz and vice 
versa. Ascend radios are currently available only in the 
800 MHz band. 

Exit - Closes the PCConfigure program. If the current 
file has been modified and the changes have not been 
saved, you are asked if the changes should be saved 
before closing.

3.2 RADIO MENU

Series - Selects the specific radio being programmed. 
Only parameters which apply to that radio are then 
displayed and others are grayed out. 

Radio Menu
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Add System - Adds a new Conventional, 
SMARTNET, SmartZone, P25 Trunked (mobile only), 
or Multi-Net system as described in Section 1.12.

Delete System - If two or more systems have been set 
up, this function deletes the system that is currently 
selected in the Per System screen.

Load System Keys - Allows the SMARTNET/Smart-
Zone/P25 trunked system keys to be loaded from a 
folder other than the default “Keys” folder. This does 
not apply to Multi-Net operation.

View Programmed Radio Wide Functions (All 
Protocols) - Displays the screen shown below which 
indicates the functions that have been assigned to the 
programmable option buttons on the Radio Wide 
screen (see Section 5.3). These buttons can be 
programmed for a different function in each mode 
(conventional, SMARTNET/SmartZone, P25 Trunked, 
Multi-Net). Up to two modes selected by the drop 
down lists are displayed.

Programmed Option Buttons Screen

3.3 TRANSFER MENU

NOTE: To stop a data transfer in progress, click  
in the toolbar (see Section 3.6).

Comports - Displays a dialog box which selects the 
serial port used to program the transceiver (see Section 
1.2). The default is COM1, and the last selected port is 
saved and then automatically reselected whenever the 
program is started. Ports 1-12 can be selected. Refer to 
Preferences in Section 3.4 for more information.

Baud Rates - All Ascend radios use the 19200 baud 
rate. Higher baud rates can be used when writing appli-
cation code (see following). Refer to Preferences in 
Section 3.4 for more information. 

Read Parameters From Radio - Transfers the infor-
mation programmed in a transceiver into a new 
programming file. If the current file has not been 
saved when this function is selected, a dialog box is 
displayed to allow it to be saved if desired. The trans-
ferred data can be viewed, edited, or saved to a disk 
file as desired. An upload password may have to be 
entered. Refer to Section 8 for more information.

Write Parameters To Radio - Programs the trans-
ceiver connected to the computer with the data in the 
current programming file. A download password may 
have to be entered. Refer to Section 8 for more 
information.

Write DSP Code To Radio - This is used only with 
early 5300 models, so does not apply to Ascend 
versions.
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NOTE: Ascend radios have safeguards to prevent 
unauthorized cloning. Refer to Section 9 for more 
information.

Write Application Code to Radio - Programs radios 
with updated firmware (operating software). Proceed 
as follows:

NOTE: This version of PCConfigure and later can be 
used only to upgrade radios to the latest release or 
later of radio firmware. Refer to Section 1.11 of the 
main manual for more information.

1. A special computer file containing the operating 
code must be obtained from EFJohnson. The 
Application code has a “.hex” extension, and the 
5300/53SL DSP code (if applicable) has an “.out” 
extension. With all 51xx/Ascend portable 
models, copy the .hex file to the PPC\5100 folder 
of the PCConfigure program, and with later 53xx/
Ascend mobile models, copy it to the PPC\5300_i 
folder. With early 53xx ARM models, copy the 
.hex file to the ARM\5300 folder, and the .out file 
to the DSP\5300 folder. Other locations can also 
be used if desired.

2. Put the radio in the firmware programming mode 
as follows. 

53xx/Ascend Mobile - Turn power on with the 
special Flash Mode Select Plug, Part No. 023-
5300-010, plugged into the microphone jack. 
Alternately, short pin 3 to 7. With the HHC, 
plug it into the programming adapter plug that 
is plugged into the junction box programming 
connector.
51xx/Ascend Portable - Turn power on with 
the option button above the PTT switch pressed.

3. Select the 115,200 baud rate with portables and 
the 57,600 rate with mobiles.

4. If applicable, make sure that the radio is 
connected to the computer and then select this 
function. Enter the password (obtained from the 
EFJohnson Company) in the screen that is 
displayed and click the OK button.

NOTE: The Boot Loader code may need to be 
updated in addition to the Application code. The 
Boot code is then updated first. The Boot Loader 

utility is selected by one password and the Applica-
tion utility by another.

5. The following screen is then displayed. Select the 
loader and code files if required by clicking the 
“Choose” button. The loader file is included with 
PCConfigure software. In some cases, an updated 
loader file may be required and would then need 
to be selected instead of the included loader file. 
The application code file should be in the folder 
selected in step 1.

6. Click the Start button to begin code downloading 
(try clicking Start again if a failure occurs). Writing 
may require 20 minutes or more. With the early 
53xx, repeat for DSP code if applicable.

NOTE: After downloading is complete, perform “Read 
Parameters From Radio” and then “Write Parameters 
To Radio” to ensure that the file format is correct.

Read Version Info From Radio - Transfers version 
information on the software the radio contains and 
then displays it as follows.
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Figure 3-1   Transfer > Read Options Screen 

Read Options From Radio - Displays information on 
which options have been enabled in the radio as shown 
in Figure 3-1. The check boxes indicate which options 
are enabled. They are for informational purposes only 
and cannot be edited.

The “Update Options” button is used to add additional 
options that have been purchased for the radio. An 
encrypted data file keyed to the radio serial number is 
provided to unlock these options. This file has an 
“.opt” extension and is selected and downloaded by a 
screen that is displayed when this button is clicked. 

Read/Write IP Address - This function is not 
currently supported. 

Read/Write Spur Frequencies - Not used with the 
51xx/53xx/Ascend.

3.4 TOOLS MENU

Toolbar Options - Displays the following dialog box 
which is used to select the icons that are displayed in 
the toolbar (see Section 3.6). When the “Custom” box 
is checked and highlighted, the additional window 
shown below is displayed to select which icons to 
display. The last selected configuration is saved and 
then automatically reselected when the program is 
restarted.

Organization Identity - Displays the following 
screen which can be used to display a unique company 
title and logo on the programmer screen. To display a 
unique company name, enter the desired name in the 
“Organization’s Name” box in this screen. It is then 
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displayed after “Radio Configuration” at the top of the 
screen (see Figure 1-3).

A logo is displayed on the right end of the toolbar, and 
when a radio read or write operation is occurring, this 
logo changes. To display the default logo, check the 
Use Default box. To display a custom logo in this area, 
create a bitmap file of the desired graphic that meets 
the following requirements. A photo editing program 
such as Photoshop® or Paint Shop Pro® can be used.

• 53 W x 22 H pixels 
• .bmp file format
• 256 colors or higher recommended
• Up to 30 files can be created named Logo1.bmp, 

Logo2. bmp, and so on up to Logo30.bmp. These 
graphics are then displayed in rapid succession 
during a radio read or write operation.

Password Management - Displays the following 
screen which is used to enable, disable, and change 
radio passwords. A radio must be connected to display 
this screen. Actual passwords are never displayed in 
this screen. Passwords, no matter what the length, are 
always represented by eight asterisks (********).

NOTE: This is a new feature available only with later 
51xx and 53xx radios with updated firmware. All 
Ascend versions have this feature.

User - This drop down list selects the particular 
password being changed as follows:

User 1, User 2, User 3, User 4 - Up to four different 
power-on passwords can be programmed. 
Currently, the same user features are available with 
each.

Upload, Download - These passwords are required 
to Upload (read) or Download (write) program-
ming parameters. A preceding “User” password is 
not required to upload or download parameters.

Master - This password overrides all the other pass-
words. It can be used by a system administrator or 
if any of the above passwords are lost.

Selected User - This box indicates status of the 
selected password (Enabled or Disabled). The Pass-
word box always indicates eight asterisks and is not 
editable.

Proceed as follows to set up or change a password. 
Passwords must be 1-8 characters in length and 
consist of numbers 0-9. Zeros are valid characters in 
any location, even as leading characters.

Changing a Password

NOTE: To enter a password, click the first asterisk 
or select all eight asterisks. If an incorrect pass-
word is entered, a red “!” exclamation point is 
displayed to the right of the box (see preceding 
screen) and the password must be re-entered.

1. Select the password in the drop down list.

2. If the password was previously set up, enter the 
current password in the Original/Master box.

If this is the first time the password is used, it 
initially consists of null (deleted) characters. In 
this case, do not enter anything in this box.

3. If the password is simply being enabled or 
disabled, click the appropriate Enable or Disable 
button. Proceed to step 6.

Incorrect
Password
Indicator
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4. If the password is being changed or initially set 
up, enter the new password in the New Password 
box and then re-enter it in the Re-enter New Pass-
word box to confirm it. Click the Change button.

5. Repeat for other passwords as required.

6. To exit without sending the change to the radio, 
click the Cancel button. To exit and send the 
change to the radio, click the OK button.

Preferences - Displays the following screens which 
set several program preferences.

PCConfigure Screen

On New

When “Always” is checked, a programming file with 
the Radio Series and Band selected by the drop down 
lists is automatically created in a single step by File 
> New or the  button. However, the Band of a file 
then cannot be changed, so only files with the 
selected Band can be created. If this is not checked, 
the Band is selected in a separate step before the file 
is created (see following).

On Exit

When selected, the parameter is restored to the 
current condition when the program is restarted. 
Otherwise, the default is selected. Note that the first 
two parameters which follow are overridden by the 
preceding “On New- Always” if it is checked.

Remember Series - The current Radio Series is 
automatically selected whenever a new file is 

created by selecting File > New or the  
button. If this is not selected, “5300” is the 
default.

Remember Band - The current frequency Band 
is highlighted (and can be changed if desired) 
when the Band select screen is displayed by 
selecting File > New or the  button. If this is 
not selected, “VHF” is the default.

Remember Baud Rate - The currently selected 
baud rate is automatically reselected (see Section 
3.3). If this is not selected, “19200” is the 
default.

Remember Keys Directory - The currently 
selected key directory is automatically rese-
lected. If this is not selected, the “Keys” folder is 
the default (see “Load System Keys” in Section 
3.2).

General

Use Hexadecimal Input - When selected, all appli-
cable numbers are entered in Hexadecimal format 
instead of Decimal format. All Hexadecimal 
numbers are indicated by an ivory-colored back-
ground. Refer to Section 1.11.4 for more 
information.

“Other” Screen

Serial Communication

Send/Get Delay - Allows a serial port delay of 
0-18 (x 56 ms) to be programmed. This delay may 
need to be programmed with computers which are 
slow to respond to serial port signals. If the soft-
ware times out during read/write operations, try 
increasing this delay. In the large majority of cases, 
the default level of “0” (no delay) should be 
selected. 
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3.5 HELP MENU

Contents - Displays the help system table of contents.

About Configuration Software - Displays the PC
Configure version number and company information.

3.6 TOOLBAR

The tools in the toolbar provide quick access to 
many menu functions. The tools that are displayed are 
selected by the Tools > Toolbar Options menu 
described in Section 3.4. The Standard, Transfer, Help, 
and Custom tools can be turned on and off by this 
menu. 

3.6.1  STANDARD TOOLS

Refer to Section 3.1 for more information.

 New - Opens a new programming file containing 
default parameters.

 Open - Loads a file from disk. Clicking the 
down arrow displays a drop-down list of recently 
loaded files.

 Save - Saves the current file to disk.

3.6.2  TRANSFER TOOLS

Refer to Section 3.3 for more information on 
these functions.

 COM Port - Selects the serial port used to 
connect the radio to the computer.

 Read Parameters From Radio - Transfers data 
from the radio to a new programming file. 

 Write Parameters To Radio - Programs the 
radio with the data in the current programming file.

 Stop Data Transfer - Cancels the data transfer 
in progress.

3.6.3  HELP TOOLS

 Help - Displays help information.

 Manual - Reserved for future use.

3.6.4  CUSTOM TOOLS

 Add System - Adds a new system. Clicking 
the down arrow displays a drop-down list of the 
system types that can be added.

 Delete System - When the Per System screen is 
displayed, clicking this button deletes the selected 
system.

 Edit Zones and Channels - Displays the Edit 
Zones and Channels screen. 

 Edit Radio Wide Scan List - Displays the Radio 
Wide Scan List edit screen.

 Read Version From Radio - Reads version 
information from the radio for the software it contains 
and then displays that information.

 Read Options From Radio - Reads option 
information from the radio and then displays it. 

 Write DSP Code To Radio - Not used with 
5100 models.

 Write Application Code To Radio - Programs 
the radio with new Application/ARM software.

3.7 STATUS BAR

The status bar shown in Figure 3-2 indicates the 
following information: 

Band - The frequency band of the file. This is selected 
when a new file is created by the File > New function.

Series - The Radio Series of the file selected by the 
Radio > Series function.

File - The file name of the current programming file. 
This name is specified the first time the file is saved by 
the File > Save function or it can be changed by the 
File > Save As function.
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Figure 3-2   Status Bar

InformationDecimal/Hexadecimal Indicator

Size - Indicates the percent of the available memory 
space that would be used if the radio was programmed 
with the current file (see Section 1.11).

D/H Box - Indicates if the Decimal or Hexadecimal 
number format is selected (see Section 1.11.4).

Information - Displays a short description of tools in 
the toolbar when they are selected by the cursor.

3.8 ORGANIZER

Clicking the organizer button  on the right 
end of the toolbar toggles the preceding screen which 
can be used to organize a large number of program-
ming files into groups and subgroups for easier identi-
fication when administering a large organization. 

NOTE: This organizer does not add, delete, or move 
programming files on the hard drive. It simply orga-
nizes those files in logical folders and subfolders.

Groups are indicated by a folder symbol , 
and programming files are indicated by a  symbol. 
A  symbol next to an item indicates that the branch 
is expanded, and clicking it collapses the branch. Like-

wise, a  symbol indicates that the branch is 
collapsed, and clicking it expands the branch. If a file 
in the organizer has been deleted from the hard drive, 
it is indicated by a red “X” through the icon .

1. To add the current programming file to the Orga-
nizer, select the desired Group in the Organizer and 
then select the File > Send to Selected Organizer 
Group menu item (see Section 3.1). To add other 
files, see step 3.

2. To open a file listed in the Organizer, simply double 
click it, drag it to the main programmer screen, or 
select “Open” as described in the next step.

3. To add, edit, delete, or move a group or file, right 
click the applicable group or file and the following 
screen is displayed.

Open - Opens the selected file. If the current file has 
not been saved, you are asked if you would like to 
save it first.

Add Group - Adds a new group below the selected 
location.

Add File(s) - Displays a screen that is used to select 
a file on the hard drive to add to the selected location.
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Delete Group - Deletes the selected Group from the 
Organizer only (the actual files on the hard drive are 
not deleted).

Delete File - Deletes the selected File from the Orga-
nizer only (the actual file on the hard drive is not 
deleted).

Show Full Path - Displays the entire path name of the 
file on the hard drive.

Cut - Moves the selected Group or File to the 
clipboard.

Copy - Copies the selected Group or File to the 
clipboard.

Paste - Copies the current file on the clipboard to the 
selected location

Rename - Renames the selected Group. Files cannot 
be renamed from the Organizer.
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GLOBAL SCREEN PARAMETERS

SECTION 4   GLOBAL SCREEN PARAMETERS

Figure 4-1   Global Parameter Programming Screen

4.1 INTRODUCTION

The Global screen shown in Figure 4-1 programs 
parameters that are the same for all systems, channels, 
and zones. Only parameters that apply to the selected 
Radio Series are displayed and the others are grayed 
out. The parameters in this screen are as follows:

4.2 PARAMETER DESCRIPTION

Systems

Displays the number of systems that have been 
created as described in Section 1.12. 

Zones (A zone is a programmed collection of up 16 
channels of any type.)

Number of Zones - The total number of zones 
currently set up. The maximum number allowed 

is 16 (mobile) or 32 (portable). Zones are created in 
the Zone > Edit Zones screen by clicking the “+” 
button (see Section 6.2).

Home Zone - Selects the zone that is selected by the 
Home Zone option function button (if programmed).

Power Up In - Selects if the transceiver powers up on 
the Home or Last Selected zone/channel. 

Power Up Zone - When data is uploaded from a 
radio, this number indicates the power-up zone in the 
radio. It does not change until the current data is 
downloaded and then uploaded again.

Channels

Home Channel - Selects the channel that is selected 
by the Home Zone function button (if programmed) 
and when the transceiver powers up on the Home 
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zone. With the 51xx/Ascend portable, this is select-
able only if the channel selector switch is disabled 
(see “Channel Selector Enabled” parameter on 
page 23). 

Power Up In - Selects if the Home or Last Selected 
channel is selected on power up. With the “Last 
Zone”/“Home Channel” power up configuration, the 
programmed home channel number of the last active 
zone is selected. If that channel number is not 
programmed, “Unprogrammd” is displayed. With 
the 51xx/Ascend portable, only “Home Channel” is 
available if the channel selector switch is enabled. 

Power Up Channel - Indicates the power-up channel 
in the radio similar to the power-up zone just 
described. 

Global Emergency Channel

Selects the zone and channel on which all emergency 
calls and alarms are transmitted regardless of the 
type of channel currently selected. For example, if 
the global emergency channel is a conventional 
channel and a trunked channel is selected when the 
emergency is initiated, it is transmitted on the 
conventional global emergency channel. If this is a 
Multi-Net channel, the auto/manual emergency 
programming of the selected system determines the 
emergency mode. 

Cursor (53xx/Ascend Mobile Only)

Cursor Time-Out - Programs the time delay that 
occurs before the cursor (zone or channel select indi-
cator) returns to the default position programmed in 
the next parameter. Times of 0-255 seconds can be 
programmed (“0” selects no return).

Cursor Position - Selects if the Zone or Channel 
select mode is enabled when power is turned on and 
after the preceding time-out period expires.

Battery Saver (51xx/Ascend Portable Only)

If this is checked, the portable automatically 
switches to the low transmit power mode when the 
RSSI signal indicates the site is probably nearby. 
This feature is currently not supported by Multi-Net 
operation. 

Low Battery Indicators (Portables Only)

Low Battery Beep - When checked, a short tone 
sounds periodically in the standby mode while a low 
battery condition is being detected.

Tx Chirp - When checked, a chirp sounds each time 
the PTT switch is pressed while a low battery condi-
tion is being detected.

LED Indicator - When checked, the LED on the top 
panel indicates a low battery condition. For example, 
the 51xx/Ascend indicator flashes red in the receive 
mode. 

Low Power - If this box is checked, low transmit 
power is automatically selected while a low battery 
condition is being detected.

Ignition Power Down (Mobiles Only)

When the ignition switch controls transceiver power, 
this sets the delay that occurs between when the igni-
tion switch is turned off and when transceiver power 
actually turns off. Times of 0-254 minutes or an 
infinite time (no turn-off) can be selected.

Soft Power Down (51xx/Ascend Portable Only)

The soft power down feature prevents radio power 
from being turned off by accidentally turning the top 
panel on-off/volume control. Any side option button 
can be programmed for this function (in addition to 
its normal function). Then for power to turn off, this 
button must be pressed during or just after power is 
turned off by the on-off switch. 

Sound

Alert Tone On - If checked, all supervisory tones 
sound. If not checked, no tones sound.

Horn Cadence (53xx/Ascend Mobile Only) - 
Programs the following styles when the horn alert is 
enabled by the horn alert option switch. Repeating 
does not occur with either style.

Style 1 - The horn is on for 1 second and off for 
0.5 second for three cycles.
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Style 2 - The horn sounds continuously for the 
programmed time (2-255 seconds).

Minimum Volume - Sets the minimum volume level 
that can be selected by the volume control. This can 
be used to prevent missed messages caused by inad-
vertently turning the volume down too far. Relative 
levels of 0-255 in steps of 1 can be set (“0” sets the 
lowest minimum volume).

Tone Volume - This adjusts the alert tone volume 
level relative to the volume control setting. This can 
also be done by a Tone Volume Edit option button if 
programmed. Changes made by this button perma-
nently override this setting. Relative levels of –170 to 
+170 in steps of 1 can be set (“0” is the standard 
default setting). 

 Mic Levels - Displays the following 
screen which sets the microphone sensitivity for 
various types of calls. Relative levels of 0 (less 
sensitive) to 4 (most sensitive) are set for Analog, 
Digital, and SecureNet® (encrypted) calls with “4” 
the default. “Analog” sets the level for Multi-Net 
operation.

Keypad (Portables Only)

Keypad Type - Selects if the portable being 
programmed has a Full DTMF Keypad or a Limited 
Keypad (without the 0-9, *, # DTMF keys).

Permanent Keypad Lockout* - If checked, the front 
and side panel keys are permanently disabled and 
cannot be re-enabled by the user. If the “Front Only 
Keypad Lockout” parameter which follows is 
selected, only the front panel keys are permanently 
disabled and the side panel keys can still be used. 

Lock Channel Selector - When checked, the top 
panel channel selector switch is also temporarily 
locked by the Keypad Lockout function. When not 
selected, it remains functional when the keypad is 
locked. To totally disable this control, do not select 
“Channel Selector Enabled” which follows. 

Lock Volume Knob - When checked, the top panel 
volume control function (but not on-off) is also 
temporarily locked by the Keypad Lockout function. 
When not selected, it remains functional when the 
keypad is locked. To totally disable this control, 
program an Up/Down volume button (see following 
“Volume Ticks” parameter).

Front Only Keypad Lockout* - This controls the 
keys that are disabled by the preceding Permanent 
Keypad Lockout function and the Keypad Lockout 
option button if programmed. If neither or these 
functions are used, checking this parameter has no 
affect. If checked, the front panel keys are disabled 
but the side panel keys remain active. If not checked, 
both the front and side panel keys are disabled. 

Backlight During Keypad Lockout - When checked 
the backlight turns on normally when a key is pressed 
with the keypad is locked (if Backlight on Keypress 
which follows is enabled). If not checked, the back-
light is also disabled when the keypad is disabled. 

Other

Hang-Up Box Monitor (Mobiles Only) - When 
checked, enables microphone off-hook detection. 
Taking the microphone off-hook then enables the 
monitor mode (conventional only) and disables scan-
ning. When not checked, taking the microphone off-
hook has no affect on these functions.

Backlight on Keypress (Portables Only) - If checked, 
the backlight turns on for the Backlight On Time 
whenever a key is pressed.

Programmed Channels Only on Display (53xx/
Ascend Mobile Only) - If checked, only programmed 
channels can be selected, and if not checked, all 
channels are displayed. When an unprogrammed 
channel is selected, “UNPROGRAMD” is indicated 
and a tone sounds. 

Backlight On Time (Portables Only) - Programs the 
length of time in seconds that the backlight stays on 
after it is enabled by pressing a key (see preceding). 
Times of 0-7.5 seconds in 0.5-second steps can be 
programmed. When turned on by the option switch 
or menu parameter, it stays on until turned off again.
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Figure 4-2   Global Screen (Page 2)

Backlight Level (53xx/Ascend Mobile Only) - 
Selects the backlight brightness as Off, Mid, or High 
whenever power is on. This setting can be overridden 
by the Backlight option switch if it is programmed.

Controller Type (53xx/Ascend Mobile Only) - 
Selects the type of control head being used. 
“Normal” is selected with the standard front or 
remote mount control head, and “Handheld” is 
selected with the Handheld Control Unit. 

Volume Ticks (51xx Only) - When a Volume Up/
Down button is programmed on the Radio Wide 
screen for a particular system type, the volume 
control is disabled when a channel programmed for 
that system type is selected. This then selects the 
number of button presses (ticks) required to change 
from minimum to maximum volume. From 1-50 
steps can be programmed. See also preceding “Lock 
Volume Knob” parameter.

Menu Enabled (51xx/Ascend Portables Only) - 
Enables the menu mode with these portables. The F1 
and F2 keys then become menu exit and select keys 
instead of programmable option keys. If this param-
eter is not selected, the menu mode is not available 
and F1 and F2 are programmable option keys.

Channel Selector Enabled (51xx/Ascend Portable 
Only) - Enables the channel select knob in the top 

panel. If this is not checked, the channel select knob 
is disabled and channels can be selected only by the 
Channel Select option button or menu parameter.

Ignore Clear/Secure Switch When Strapped - This 
applies to encryption switching which is currently 
not available with Multi-Net operation.

Surveillance Mode - Disables the transmit/receive 
LED indicator, display and keypad backlight, and all 
alert tones. This provides a quick way of totally 
disabling these functions in all operating modes. It 
overrides any other programming of these functions 
such as a Tone or Backlight option switch. This does 
not disable the transmit icon in the display (available 
only with 51xx, firmware Version 2.5 or later). 

LED Disabled w/Backlight Off (5300/Ascend 
Mobile Only) - When selected, the front panel 
transmit indicator is disabled whenever the display 
backlight is off. If it is not checked, this indicator 
operates normally regardless of the backlight state 
(except when the surveillance mode is selected).

4.3 PAGE 2 GLOBAL SCREEN DESCRIPTION

A second Global screen shown in Figure 4-2 is 
opened/closed by clicking the  buttons in the 
upper right corner of the screen. These additional 
parameters are then displayed:
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PA (53xx/Ascend Mobile Only)

Rx Audio to External PA - Microphone audio is 
always routed to the Ext PA line of the accessory 
cable. If this parameter is selected, receive audio 
signal is also routed to this line. 

External PA Display Indication - If this is selected, 
“Ext PA On” is indicated continuously in the display 
when the external PA function is enabled by the Ext 
PA option button. If it is not selected, “Ext PA On/Off 
is flashed in the display when a button is pressed.

OTAR/Key Management

Selects the OTAR unit RSI and also the method 
used to load and manage encryption keys. Since 
encryption is currently not available with Multi-Net 
operation, this section does not apply to Multi-Net 
channels.

Emergency Man Down (51xx/Ascend Portable 
Only)

The Emergency Man Down feature automatically 
selects the emergency mode if the radio remains in a 
horizontal position for the programmed time. The 
emergency mode selected by this feature functions 
the same as if the emergency button had been 
pressed. An optional man-down device must be 
attached to the accessory port of the radio, and this 
feature must be selected. 

The timer can be programmed for 0-63 seconds, and 
it resets if the radio is moved back to a horizontal 
position. The emergency mode can be canceled by 
pressing the emergency button. This feature is avail-
able only with Version 2.5.13 or later firmware.

GPS (53xx/Ascend Mobile Only)

This feature is currently not available. It programs a 
GPS feature that can be used with other equipment to 
determine the geographical location of the subscriber 
unit. 

Other (53xx/Ascend Mobile Only)

Auxiliary B Output - Determines the function 
controlled by Pin 4 output of the accessory 
connector: 

Backlight - When the Siren option is used, the 
control head backlight also controls the Siren 
Controller backlight.

Horn - Controls an external horn alert.

Site Trunking - Controls an external site trunking 
indication of some type with SmartZone and P25 
trunked operation.

Disabled - The output is nonfunctional.

Auxiliary B Input - Determines the function 
controlled by Pin 8 input of the accessory connector:

PA Broadcast - Selected with the Transit Bus PA 
option only to allow the public address function to 
be selected by an external switch.

Ext Emergency - Selected if an external emer-
gency switch, such as a foot activated type, is used 
to activate an emergency condition.

Disabled - The input is nonfunctional.
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RADIO WIDE SCREEN

SECTION 5   RADIO WIDE SCREEN

Figure 5-1   Radio Wide Multi-Net Screen

5.1 INTRODUCTION

The Radio Wide screen programs parameters that 
are the same for all Multi-Net systems. The Multi-Net 
screen is shown in Figure 5-1. 

5.2 RADIO-WIDE SCAN LIST PROGRAMMING

NOTE: The radio-wide scan list cannot be 
programmed until all channels to be included in it 
have been set up in the Zone screens (see Section 6).

The Radio Wide scan list is the same for all 
system types and can include up to sixteen channels 
from any system. This scan list is programmed by 
clicking the  button on this screen or 

 in the toolbar. The following Radio Wide Scan 
List screen is then displayed.

To select the channels that are in the radio wide 
scan list, click the  button to display the 
Modify Scan List screen. Select the desired zones 

from the drop-down list and then check the channels to 
be included from each zone in the list. 

Radio-Wide Scan List Screens

Scan Talk Back Type

When a call is received while radio wide scanning, 
this determines if a response occurs on the Selected 
Channel or the channel of the call (Active Channel) 
when they are not the same.

Modify Scan List Screen
Radio Wide Scan List Screen
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Scan Hold Time

When Radio Wide scanning is occurring, this 
programs the delay that occurs after a message is no 
longer being received or transmitted before scanning 
resumes. Times of 0 - 7.5 seconds can be 
programmed.

5.3 RADIO WIDE MULTI-NET PARAMETERS

Clicking “Multi-Net” in the “System Specific” 
box displays the screen shown in Figure 5-1. This 
screen programs the functions that are the same for all 
Multi-Net systems. 

RSSI Threshold

This sets the RSSI (Receive Signal Strength Indi-
cator) levels. Currently, only the “Acceptable” level is 
used. The RSSI of a site must exceed this level for it to 
be considered as a candidate for a new site by the site 
search procedure. Clicking the “Restore Defaults” 
button restores these levels to the default setting. If the 
“Hex” box is checked, the RSSI levels are displayed in 
the hexadecimal instead of decimal notation.

NOTE: The default RSSI levels should not be changed 
unless you are familiar with how these levels affect 
radio operation.

Radio Wide Lists

The various Multi-Net radio wide lists are 
programmed by selecting them in the Radio Wide 
Lists drop-down list shown above and then clicking 
the Edit List button. Descriptions of the various lists 
and the information they program follow.

Phone List

The Phone List screen which follows programs 
the list of phone numbers that can be recalled for 
Multi-Net Telephone calls. Up to 16 numbers can be 
stored, and each number can be up to 16 digits. The * 
and # characters cannot be stored. To store a pause,

enter a “p” or “P”. Numbers up to the pause are sent, a 
short delay occurs, and the remaining numbers (or the 
numbers to the next pause) are sent. A pause counts as 
one character. The alias can be up to 10 alphanumeric 
characters.

Unit Call List

The Unit Call List screen shown above programs 
the list of numbers that can be recalled for Multi-Net 
Unit/Unique ID and Directed Group calls. Up to 16 
numbers can be stored. Individual (Unique) IDs for 
Unit calls are 4 or 7 digits in length, and Directed 
Group call numbers are 5 or 8 digits in length. The 
longer number is required if the call is to another site 
and the site ID must be specified. The alias can be up 
to 10 alphanumeric characters. Refer to the operating 
manual for more information on these numbers.

Status Message List

The Status Message List screen which follows 
programs the up to eight status messages that can be 
selected. The message assigned to each number should 
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be the same as that programmed in the dispatcher 
console. Each message can be up to 10 alphanumeric 
characters.

Status Message List Screen

Menu Items Programming

The menu function is available with 51xx/Ascend 
portables only. The menu mode can be user selected if 
the “Menu Enable” box on the Global screen is 
checked. Clicking the  button displays 
the following screen which is used to select the func-
tions that are selectable in the menu mode. To move a 
function to the other list, double click it or select it and 
click one of the single arrow buttons. Clicking a 
double arrow button move all items to the other list. 

A separate set of menu parameters can be 
programmed for each system type similar to the

Menu Programming Screen

function buttons described in the next section. The 
system type being programmed is selected in the 
“System Specific” box of the Radio Wide screen. 
Functions can be controlled by both the menu and a 
function button if desired. The available menu func-
tions are shown in Table 5-1.

Function Button Programming

Clicking  in the Radio Wide screen 
displays a screen similar to the one shown in 
Figure 5-2 that programs the function buttons for the 
radio selected by Radio > Series. 

Each button can be programmed with a function 
for Multi-Net channels, and others for Conventional, 
SMARTNET/SmartZone, and Project 25 Trunked 
systems. The system type is selected in the “System 

Figure 5-2   Assign Function Buttons Screen

Click Button
To Program It
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Specific” box of the Radio Wide screen. The available 
option button functions are shown in Table 5-1.

NOTE: To view the functions programmed for each 
button in the various modes, select Radio > View 
Programmed Radio Wide Functions (see Section 3.2).

Program the function buttons as follows:

1. Click the white “Fx” button being programmed in 
the photo and a drop-down list is displayed showing 
the functions that can be assigned (with the 51xx 
portable, almost all buttons are programmable).

2. To select a function, double click it in the drop-down 
list. The functions that have been assigned to each 
button are displayed in the bottom part of the screen.

3. Repeat for all function buttons that are to be 
programmed. Then click OK to exit and save the 
changes or Cancel to exit without saving the 
changes. Then select the other system type if 
applicable and repeat this procedure.

Scan Delay Timers

These timers program various setting for Multi-
Net group scanning. Radio wide scan settings are 
programmed on the Radio Wide screen.

Call Delay - Programs the delay before scanning 
resumes after responding to a message.

Receive Delay - Programs the delay before scanning 
resume after receiving a message.

Display Options

These functions select what is displayed when a 
group call is received. It does not affect the informa-
tion displayed when a special call is received.

None - Only the talk group alias of the call or the 
selected talk group alias is displayed, depending on 
the call type.

Both - Both of the following are displayed.

PTT ID - The individual (unique) ID of the mobile 
placing the call is displayed. The time this ID is 
displayed is programmable for 0.5-7.0 seconds or

infinite. When “infinite” is selected, this ID is 
displayed for the entire call and none of the other 
parameters are displayed. The channel (group) alias 
is then displayed continuously.

Talk Group on Rx - The group ID on which the call 
is received is displayed. The same times are 
programmable as with the preceding PTT ID.

Alternating Display - If checked, the PTT ID and 
channel alias are alternately displayed when the call 
is active. They alternate at the time set by the PTT ID.

Other

Disable PTT Queuing (Camp-On) - When selected, 
the PTT switch cannot be held down while a message 
is being received in order to immediately access the 
system when it is finished.

Table 5-1   Multi-Net Mode Option Switch and 
Menu Functions

Function Menu
Display

Option 
Switch

Backlight On-Off Backlight X
Call Response Call Rsp X
Channel Select Chan Selct X
Emergency Select Emergency X
Group Scan Select Grp Scan X
High/Low Power Sel Tx Power X
Home Zone Select Home Zone X
Keypad Lockout Sel (Opt sw only) X
Phone Call Select Phone X
Radio Wide Scan Sel RW Scan X
RWS List Edit RWS Edit X
Scan Edit Scan Edit X
Set User Password Set Pswd X
Site Lock Site Lock X
Site Search Select Site Srch X
Status Select Status X
Surveillance Mode Sel Surv Mode X
Tone Volume Edit Tone Vol X
Unit Call Select Priv Call X
Unprogrammed - -
Volume Down (portable only) (Opt sw only) X
Volume Up (portable only) (Opt sw only) X
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System Access (Busy) Queuing - When selected, 
Telephone and Unit calls are placed in a queue if the 
radio system is busy when the PTT switch is pressed. 
An alert tone then sounds when the call can be 
placed. This tone may not sound with early units.

Auto-Registration - When selected, auto-registration 
is enabled which causes the radio to automatically 
register on the current Multi-Net site with the stron-
gest signal. If this is not selected, registration does 
not occur until the PTT switch is manually pressed. 

Kill Setting - This selects if the radio can be disabled if 
it becomes lost or stolen. If disabling is allowed, the 
ability to interrogate the radio can also be enabled or 
disabled.

Talkback Scan - When the PTT switch is pressed to 
respond to a message in the group scan mode, selects 
if the transmission always occurs on the Selected, 
Active, or Last Received group. When not scanning or 
if no message is being received, transmissions always 
occur on the selected group.

SECTION 6   SETTING UP ZONES AND CHANNELS

Figure 6-1   Edit Zones and Channels Screen

Double Click Here
To Display Screen Below

6.1 INTRODUCTION

The following information describes how to set 
up zones and assign channels to each zone. A zone can 
include up to 16 channels of any type (Multi-Net, 
conventional analog, Project 25 conventional, 
SMARTNET/SmartZone, or Project 25 Trunked). 

Up to 16 zones can be programmed for up to 256 
channels. However, if the 51xx portable has the 512 

channel option (see page 14), up to 32 zones or up to 
512 channels can be programmed.

6.2 SETTING UP ZONES

1. Select the Zone screen (see Figure 6-1). Then click 
 to display the Edit Zones and Chan-

nels screen shown in Figure 6-1. Alternatively, click 
 in the toolbar.
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2. To add a new blank zone, select “None” in the Zone 
drop-down list and then click the  button. To 
make a copy of a current zone, select the desired 
zone in the Zone drop-down list instead. To delete 
the current zone, click the  button. 

3. To display the first zone, click , the last zone ; 
the previous zone ; and the next zone, . 

4. Program the alias (identification) that is briefly 
displayed when the zone is selected by entering up 
to 10 characters in the Alias box.

5. The zone password does not apply to Multi-Net 
operation. It is used for keypad programming which 
is available with conventional operation only.

6.3 SETTING UP CHANNELS

NOTE: When channels are assigned to zones, the 
system of the channel is also selected. Therefore, 
before assigning channels to zones, all necessary 
systems must be set up as described in Section 1.12.

Channels are set up by assigning them to a zone 
in the Edit Zones and Channels screen shown in 
Figure 6-1. Proceed as follows to set up Multi-Net 
channels. 

1. If necessary, select the Zone screen (see Figure 6-1) 
and then click  to display the Edit 
Zones and Channels screen shown in Figure 6-1. 
Alternatively, click  in the toolbar.

2. Select the desired zone as described in the preceding 
section. 

3. To add a channel to the displayed zone, check the 
applicable box in the “Channel” column. To select 
or de-select all channels in the box, check or 
uncheck the “All” box. 

4. To assign the channel to a system (if applicable), 
select the drop-down list in the “System/Type” 
column and select the desired system.

5. To copy an enabled channel to unprogrammed chan-
nels of the current zone or other zones, double click 
the shaded area of the channel as shown in 
Figure 6-1. The “Distribute Channel Data” screen is 
then displayed to select the desired channels.

6. Repeat the preceding steps until the desired chan-
nels are set up in each zone. 

7. To program individual Multi-Net system and 
channel information, refer to Section 7. 
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SECTION 7   MULTI-NET SYSTEMS AND CHANNELS

Figure 7-1   Individual Multi-Net System Screen

7.1 INDIVIDUAL MULTI-NET SYSTEM 
PARAMETERS

Individual system parameters are programmed by 
the “Per System” screen shown in Figure 7-1. These 
parameters can be programmed after the desired 
systems have been set up as described in Section 1.12. 

There are also radio wide parameters that are 
programmed by the Radio Wide screen as described in 
Section 5.3. The parameters in the individual Multi-
Net System screen are as follows:

System

Individual (Unique) ID - Programs the individual ID 
of the radio when the system is accessed.

Home Repeater - Programs the home repeater 
number of the system. This number plus the channel 
group ID determine the mobile or group of mobiles 
that receive a group call.

Alias - Programs the alias of the system. This alias is 
used as an identification aid for programming and is 
not displayed by the radio.

RSSI

Site Scan Dropout Criteria - Programs the 
percentage of good data messages that must be 
received to stay on the site when roaming. The higher 
this setting, the sooner roaming occurs because fewer 
bad messages are permitted. The default is 25%.

Response Time - This is sampling period for deter-
mining Dropout Criteria. This parameter is not 
currently used and is fixed at 10 seconds.

Emergency

Zone/Channel - Selects the Zone and Channel on 
which an emergency is transmitted when a channel 
linked to that system is selected. Any type of 
programmed channel can be selected and the emer-
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gency responds according to that channel type (such 
as Multi-Net, Conventional, SMARTNET). If a 
global emergency zone/channel is programmed on 
the Global screen, a system emergency zone/channel 
is not programmable. 

Auto Tx - When selected, emergency messages are 
automatically transmitted, and when not selected, 
they must be manually transmitted. If the global or 
system emergency zone/channel is a Multi-Net 
channel assigned to the system, this determines the 
auto/manual mode of that emergency zone/channel. 
Otherwise, this parameter is ignored.

System Lists

The various Multi-Net system lists are 
programmed by selecting them in the System Lists 
drop-down list shown above and then clicking the Edit 
List button. Descriptions of the various lists and the 
information they program follow.

Site List

The Site List screen shown above programs the sites 
that are linked to the system. Up to 32 sites can be 

liked to each Multi-Net system. To display this 
screen, on the Multi-Net Per System screen, select 
Site List in the drop-down list and then click the 

 button (see Figure 7-1). 

To add a site, click the  button, and to delete 
an site, simply select it and click the Delete button. 
To edit an site, select it and change it as desired. The 
following site information is programmed: 

Alias - Up to 10 characters can be entered that iden-
tify the site. This identification is displayed when the 
site is selected or displayed using the Site Search 
feature. 

Key - This is the unique site key that is programmed 
in both the radio and site repeaters to prevent unau-
thorized use of the system. This key is provided by 
the EFJohnson Company. For security purposes, the 
actual key is never displayed and is represented by 
asterisks (********).

Splinter Channels - Selects if channels are offset 12.5 
kHz on the low side. This channel offset is required 
for 800 MHz channels 1-600 in some border areas.

Status Channel Tx/Rx Channel Number - Programs 
the channel number or frequency of the status 
repeater for the site. The system Channel Designa-
tion parameter determines if this is entered as a 
frequency or EFJ Channel number (see description 
which follows).

If EFJ channel numbers are used, be sure to use the 
EFJ Programming Channel Number, not the FCC 
Channel Number. The FCC channel numbering 
scheme skips some channels above 600, so a 
different scheme must be used. The 800 MHz EFJ 
Programming Channels are listed in a table at the 
back of this manual. 

Home Channel Tx/Rx Channel Number - Programs 
the channel number of the home repeater for the site 
similar to the status channel just described. 
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Group Scan List

The Group Scan List screen shown above programs 
the channels in the group scan list for that system. A 
different list can be programmed for each Multi-Net 
system. Only Multi-Net channels linked to the 
system can be added. To display this screen, on the 
Multi-Net Per System screen, select Group Scan List 
in the drop-down list and then click the  
button (see Figure 7-1). 

To edit this list, click the Modify  button and 
the following screen is displayed. Select the appli-
cable zone in the drop-down list and the Multi-Net 
channels in that zone that are linked to the current 
system are displayed. Click the All box to select all 
displayed channels or click the box in the Channel 
column to select individual channels.

Fixed Priority 1 and 2

Programs the fixed priority 1 and 2 channels on 
which calls are received regardless of what system 
channel is selected. The call indicator function is 
currently not available. 

Transmit Inhibit IDs

Programs the Transmit Inhibit ID block of IDs which 
can include up to all 225 IDs. When an ID within this 
block is detected up to 5 seconds before the PTT 
switch is pressed, the transmitter does not key. 

Block Decode IDs

Programs a block of ID codes up to all 225 on which 
calls are received regardless of what system channel 
is selected. 

Timers

Transmit Time-Out - Programs the time-out timer for 
15-225 seconds. Programming “0” disables this 
timer. 

Penalty - Programs the penalty timer for 15-225 
seconds. Programming “0” disables this timer. This 
timer disables the transmitter for the programmed 
time after it is disabled by the time-out timer.

Dynamic Group Assignment

Programs the Multi-Net Zone/Channel that is repro-
grammable over the air by the Dynamic Reassign-
ment command. Any of the available 16 channels per 
zone can be selected even channels that are not 
enabled. With this radio, the System number trans-
mitted by the dispatcher is the System Index number 
of the system from this screen.

Other

Frequency Designation - Selects if the Status and 
Home repeater channel numbers programmed in the 
Site List are entered as Channel Numbers from the 
Programming Channel List at the end of this manual 
or as the actual channel frequencies in megahertz. 
See preceding “Site List” for more information.

Unit Call - Programs the permission for placing and 
receiving Unit calls on the system. These calls can be 
Disabled, Response Only, or Send/Receive. This also 
applies to placing Directed Group calls because they 
are placed as Unit calls and received as Group calls. 

Phone Interconnect - Programs the permission for 
Telephone calls similar to Unit calls just described.

Interconnect Priority/Preemption 

Tx Priority - Sets the access priority for Intercon-
nect (Telephone) calls on the system for 2-5 
(“2” programs the highest priority). Priority “1” 
is reserved for emergency calls.
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Rx Preemption - Selects which calls Intercon-
nect calls can interrupt. The priority of calls is as 
follows. This selects the highest priority call 
that can be interrupted. For example, if Group 
Scan is selected, only Group Scan and Block 
calls are interrupted. 

1. Fixed Priority 2
2. Selected
3. Group Scan
4. Block

Unit Call Priority/Preemption - Sets the Transmit 
Priority and Preemptions for Unit calls similar to 
Interconnect calls just described.

Transmit Power - Fixes the transmit power for the 
system for the high or low level or makes it select-
able (the High/Low Power switch is then required).

Figure 7-2   Multi-Net Channel Screen

7.2 MULTI-NET CHANNEL PARAMETERS

After the desired channels have been set up as 
described in Section 6.3, individual channel parame-
ters can be programmed. Select the Zone screen shown 
in Figure 6-1 and then select the desired Zone using 
the drop-down list in the “Zones” box. The screen 
which programs individual channel parameters are 
selected by clicking the channel in the “Channels” 
box.

Channel Type

Indicates the type of channel (Multi-Net) that is 
currently selected in the “Channels” box.

Channel Alias

Programs the alias (identification) that is displayed 
when the channel is selected. Up to 10 alphanumeric 
characters can be entered.

Transmit

Group ID - Programs the encode ID from 1-225.

Disabled - When selected, transmitting is disabled on 
the group so it is monitor only.
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Priority - Selects the access priority of the group 
from 2-5 (“2” is the highest priority). Priority “1” is 
reserved for emergency calls.

Receive

Group ID - Programs the decode ID from 1-225. The 
receive and transmit IDs can be different if desired.

Other

Call Indicator - The Call indicator feature is not 
currently available. This selects if the Call Indication 
is displayed when a call is received on the channel.

Horn Indicator (53xx/Ascend Mobile Only) - When 
selected, the horn alert activates when a call is 
received on the channel.

PTT Tone Delay - Not currently used because 
encryption is not available on Multi-Net channels. 
This delays the following Talk Permit Tone for a 
short time when encryption is used to ensure the 
receiving radio has time to detect the call. 

Talk Permit (Proceed) Tone - When selected, the 
Talk Permit Tone sounds when the radio system is 
successfully accessed and speaking can begin. If this 
is not selected, no tone sounds when this occurs.

SECTION 8   PASSWORD DESCRIPTION

8.1 NEW PASSWORD ENHANCEMENTS

8.1.1  INTRODUCTION

A new enhanced password feature is now avail-
able for 51xx/Ascend portables and 53xx/Ascend 
mobiles. The single Power-On password has been 
replaced by the following passwords: 

• Four Power-On (User x) Passwords 
• Download and Upload Passwords
• Master Password

8.1.2  SOFTWARE VERSIONS REQUIRED

The following revised PCConfigure and radio 
software is required for these new enhanced password 
features:

PCConfigure - Version 1.21.8 or later 

Ascend Portable and Ascend Mobile - All Ascend 
versions of these radios have the new password 
features. 

8.2 PROGRAMMING PASSWORDS

8.2.1  GENERAL

With later versions of PCConfigure, passwords 
are programmed using a password management screen 

displayed by the Tools > Password Management menu 
(see Section 3.4). The applicable radio must be 
connected to the computer to display this screen. 

Password data is transferred and stored in an 
encrypted format for security purposes. In addition, 
actual passwords are never displayed. They are always 
indicated by eight asterisks (********). Therefore, it 
is not possible to determine what passwords are in a 
radio using the PCConfigure software.

Passwords must be 1-8 characters in length and 
consist of the numbers 0-9. Zeros are valid characters 
in any location, even as leading characters. Initially, all 
passwords are null (deleted) characters. Therefore, 
when initially programming a password, no entry is 
required in the “Original/Master Password” box.

8.2.2  LOST PASSWORDS

If a password is lost, it can be changed using 
PCConfigure by entering the Master password (see 
following). If even the Master password is lost or was 
not used, all passwords (and other radio programming) 
can be erased using the PCTune software as follows:

1. With PCTune, Version 1.1.1.0 or later, simply select 
Radio > Reset Passwords. 

2. With earlier versions of PCTune, after starting the 
PCTune program, press SHIFT CTRL E to toggle 
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the following Erase EEPROM function (otherwise it 
is grayed and not selectable). Then select Radio > 
Erase EEPROM > Params Only. NOTE: DO NOT 
SELECT “COMPLETE” because that erases all 
information and the radio must then be sent back to 
the factory to make it usable again.

8.2.3  CHANGING PASSWORD

An assigned password can be changed by the user 
if the “Set User Password” option button or menu 
parameter (51xx/Ascend portable only) is 
programmed. Selecting this function displays prompts 
for entering and confirming a new password. 

NOTE: With the 51xx/Ascend portable and 53xx/
Ascend Handheld Control Unit, it is recommended that 
a number key not be used for this function because the 
password mode is exited if that key is pressed to enter 
a number.

8.2.4  PASSWORD ENTRY PROCEDURE

Whenever a password is requested, it is entered as 
follows:

Mobiles - Rotate and press the Select switch.

Portables - With DTMF keypad models, enter each 
number using the keypad and press the F2 (Enter) key 
after the last digit is entered. With limited keypad 
models, enter each number by pressing the Up/Down 
switch and press the F2 key after each digit.

8.3 PASSWORD DESCRIPTION

8.3.1  USER (POWER-ON) PASSWORDS

When a User Password is enabled, it must be 
entered each time radio power is turned on. Up to four 

different User Passwords (User 1/User 2/User 3/
User 4) can be programmed. Currently, the same radio 
features are enabled for each. Entering any User Pass-
word at power up enables normal radio operation.

8.3.2  DOWNLOAD/UPLOAD PASSWORDS

Separate Download (write) and Upload (read) 
passwords can be programmed to prevent unautho-
rized downloading or uploading of radio programming 
parameters (see Section 3.3). When one or both of 
these passwords are used, the proper password must be 
entered to perform the operation. A “User” password 
is not required to upload or download parameters. 

8.3.3  MASTER PASSWORD

The Master Password overrides all the preceding 
passwords. It can be used by a system administrator as 
a “pass key” to a password controlled function or to 
change a lost or inadvertently changed password. 
Master passwords are set up and changed the same as 
the other passwords. It does not override the following 
Zone Password.

8.3.4  ZONE PASSWORD

This password is not used with Multi-Net opera-
tion. It is used only to Federal users on conventional 
systems only. It prevents unauthorized reprogram-
ming of zone using keypad programming. 
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SECTION 9   ANTI-CLONING SAFEGUARDS

NOTE: The information which follows refers to copying 
of parameters from one radio to another using the 
PCConfigure software. It is not referring to cloning 
using two radios. 

9.1 INTRODUCTION

All Ascend radios and PCConfigure software 
include safeguards to prevent unauthorized cloning of 
radios programmed for SMARTNET, SmartZone, and 
P25 trunked operation using the PCConfigure soft-
ware. With Multi-Net files, the only restriction is when 
saving a file to disk. Refer to the following for more 
information.

9.2 MULTI-NET FILE RESTRICTIONS

9.2.1  SAVING A MULTI-NET FILE TO DISK

NOTE: To save any type of new programming file to 
disk, a radio must be connected to the computer. 

All files saved to disk must be associated with a 
specific radio. Therefore, when saving a new file for 

the first time, the radio must connected to the 
computer so the ESN and other information can be 
read and stored with the file. However, a previously 
saved disk file can be opened and edited and then re-
saved to disk without a radio connected. 

9.2.2  OTHER MULTI-NET FILE RESTRICTIONS

A file uploaded from a radio can be saved to a 
disk without restrictions since it contains ESN and 
other information on the radio. 

Multi-Net files not containing restricted 
SMARTNET, SmartZone, or P25 trunked information 
can be edited and written to a radio without any 
restrictions. However, a download password may be 
required if one is programmed (see Section 8).
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1 1 851.0125 806.0125
2 2 851.0375 806.0375
3 3 851.0625 806.0625
4 4 851.0875 806.0875
5 5 851.1125 806.1125
6 6 851.1375 806.1375
7 7 851.1625 806.1625
8 8 851.1875 806.1875
9 9 851.2125 806.2125
10 10 851.2375 806.2375
11 11 851.2625 806.2625
12 12 851.2875 806.2875
13 13 851.3125 806.3125
14 14 851.3375 806.3375
15 15 851.3625 806.3625
16 16 851.3875 806.3875
17 17 851.4125 806.4125
18 18 851.4375 806.4375
19 19 851.4625 806.4625
20 20 851.4875 806.4875
21 21 851.5125 806.5125
22 22 851.5375 806.5375
23 23 851.5625 806.5625
24 24 851.5875 806.5875
25 25 851.6125 806.6125
26 26 851.6375 806.6375
27 27 851.6625 806.6625
28 28 851.6875 806.6875
29 29 851.7125 806.7125
30 30 851.7375 806.7375
31 31 851.7625 806.7625
32 32 851.7875 806.7875
33 33 851.8125 806.8125
34 34 851.8375 806.8375
35 35 851.8625 806.8625
36 36 851.8875 806.8875
37 37 851.9125 806.9125
38 38 851.9375 806.9375
39 39 851.9625 806.9625
40 40 851.9875 806.9875
41 41 852.0125 807.0125
42 42 852.0375 807.0375
43 43 852.0625 807.0625
44 44 852.0875 807.0875
45 45 852.1125 807.1125
46 46 852.1375 807.1375
47 47 852.1625 807.1625
48 48 852.1875 807.1875
49 49 852.2125 807.2125
50 50 852.2375 807.2375
51 51 852.2625 807.2625
52 52 852.2875 807.2875
53 53 852.3125 807.3125

54 54 852.3375 807.3375
55 55 852.3625 807.3625
56 56 852.3875 807.3875
57 57 852.4125 807.4125
58 58 852.4375 807.4375
59 59 852.4625 807.4625
60 60 852.4875 807.4875
61 61 852.5125 807.5125
62 62 852.5375 807.5375
63 63 852.5625 807.5625
64 64 852.5875 807.5875
65 65 852.6125 807.6125
66 66 852.6375 807.6375
67 67 852.6625 807.6625
68 68 852.6875 807.6875
69 69 852.7125 807.7125
70 70 852.7375 807.7375
71 71 852.7625 807.7625
72 72 852.7875 807.7875
73 73 852.8125 807.8125
74 74 852.8375 807.8375
75 75 852.8625 807.8625
76 76 852.8875 807.8875
77 77 852.9125 807.9125
78 78 852.9375 807.9375
79 79 852.9625 807.9625
80 80 852.9875 807.9875
81 81 853.0125 808.0125
82 82 853.0375 808.0375
83 83 853.0625 808.0625
84 84 853.0875 808.0875
85 85 853.1125 808.1125
86 86 853.1375 808.1375
87 87 853.1625 808.1625
88 88 853.1875 808.1875
89 89 853.2125 808.2125
90 90 853.2375 808.2375
91 91 853.2625 808.2625
92 92 853.2875 808.2875
93 93 853.3125 808.3125
94 94 853.3375 808.3375
95 95 853.3625 808.3625
96 96 853.3875 808.3875
97 97 853.4125 808.4125
98 98 853.4375 808.4375
99 99 853.4625 808.4625
100 100 853.4875 808.4875
101 101 853.5125 808.5125
102 102 853.5375 808.5375
103 103 853.5625 808.5625
104 104 853.5875 808.5875
105 105 853.6125 808.6125
106 106 853.6375 808.6375
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107 107 853.6625 808.6625
108 108 853.6875 808.6875
109 109 853.7125 808.7125
110 110 853.7375 808.7375
111 111 853.7625 808.7625
112 112 853.7875 808.7875
113 113 853.8125 808.8125
114 114 853.8375 808.8375
115 115 853.8625 808.8625
116 116 853.8875 808.8875
117 117 853.9125 808.9125
118 118 853.9375 808.9375
119 119 853.9625 808.9625
120 120 853.9875 808.9875
121 121 854.0125 809.0125
122 122 854.0375 809.0375
123 123 854.0625 809.0625
124 124 854.0875 809.0875
125 125 854.1125 809.1125
126 126 854.1375 809.1375
127 127 854.1625 809.1625
128 128 854.1875 809.1875
129 129 854.2125 809.2125
130 130 854.2375 809.2375
131 131 854.2625 809.2625
132 132 854.2875 809.2875
133 133 854.3125 809.3125
134 134 854.3375 809.3375
135 135 854.3625 809.3625
136 136 854.3875 809.3875
137 137 854.4125 809.4125
138 138 854.4375 809.4375
139 139 854.4625 809.4625
140 140 854.4875 809.4875
141 141 854.5125 809.5125
142 142 854.5375 809.5375
143 143 854.5625 809.5625
144 144 854.5875 809.5875
145 145 854.6125 809.6125
146 146 854.6375 809.6375
147 147 854.6625 809.6625
148 148 854.6875 809.6875
149 149 854.7125 809.7125
150 150 854.7375 809.7375
151 151 854.7625 809.7625
152 152 854.7875 809.7875
153 153 854.8125 809.8125
154 154 854.8375 809.8375
155 155 854.8625 809.8625
156 156 854.8875 809.8875
157 157 854.9125 809.9125
158 158 854.9375 809.9375
159 159 854.9625 809.9625

160 160 854.9875 809.9875
161 161 855.0125 810.0125
162 162 855.0375 810.0375
163 163 855.0625 810.0625
164 164 855.0875 810.0875
165 165 855.1125 810.1125
166 166 855.1375 810.1375
167 167 855.1625 810.1625
168 168 855.1875 810.1875
169 169 855.2125 810.2125
170 170 855.2375 810.2375
171 171 855.2625 810.2625
172 172 855.2875 810.2875
173 173 855.3125 810.3125
174 174 855.3375 810.3375
175 175 855.3625 810.3625
176 176 855.3875 810.3875
177 177 855.4125 810.4125
178 178 855.4375 810.4375
179 179 855.4625 810.4625
180 180 855.4875 810.4875
181 181 855.5125 810.5125
182 182 855.5375 810.5375
183 183 855.5625 810.5625
184 184 855.5875 810.5875
185 185 855.6125 810.6125
186 186 855.6375 810.6375
187 187 855.6625 810.6625
188 188 855.6875 810.6875
189 189 855.7125 810.7125
190 190 855.7375 810.7375
191 191 855.7625 810.7625
192 192 855.7875 810.7875
193 193 855.8125 810.8125
194 194 855.8375 810.8375
195 195 855.8625 810.8625
196 196 855.8875 810.8875
197 197 855.9125 810.9125
198 198 855.9375 810.9375
199 199 855.9625 810.9625
200 200 855.9875 810.9875
201 201 856.0125 811.0125
202 202 856.0375 811.0375
203 203 856.0625 811.0625
204 204 856.0875 811.0875
205 205 856.1125 811.1125
206 206 856.1375 811.1375
207 207 856.1625 811.1625
208 208 856.1875 811.1875
209 209 856.2125 811.2125
210 210 856.2375 811.2375
211 211 856.2625 811.2625
212 212 856.2875 811.2875
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213 213 856.3125 811.3125
214 214 856.3375 811.3375
215 215 856.3625 811.3625
216 216 856.3875 811.3875
217 217 856.4125 811.4125
218 218 856.4375 811.4375
219 219 856.4625 811.4625
220 220 856.4875 811.4875
221 221 856.5125 811.5125
222 222 856.5375 811.5375
223 223 856.5625 811.5625
224 224 856.5875 811.5875
225 225 856.6125 811.6125
226 226 856.6375 811.6375
227 227 856.6625 811.6625
228 228 856.6875 811.6875
229 229 856.7125 811.7125
230 230 856.7375 811.7375
231 231 856.7625 811.7625
232 232 856.7875 811.7875
233 233 856.8125 811.8125
234 234 856.8375 811.8375
235 235 856.8625 811.8625
236 236 856.8875 811.8875
237 237 856.9125 811.9125
238 238 856.9375 811.9375
239 239 856.9625 811.9625
240 240 856.9875 811.9875
241 241 857.0125 812.0125
242 242 857.0375 812.0375
243 243 857.0625 812.0625
244 244 857.0875 812.0875
245 245 857.1125 812.1125
246 246 857.1375 812.1375
247 247 857.1625 812.1625
248 248 857.1875 812.1875
249 249 857.2125 812.2125
250 250 857.2375 812.2375
251 251 857.2625 812.2625
252 252 857.2875 812.2875
253 253 857.3125 812.3125
254 254 857.3375 812.3375
255 255 857.3625 812.3625
256 256 857.3875 812.3875
257 257 857.4125 812.4125
258 258 857.4375 812.4375
259 259 857.4625 812.4625
260 260 857.4875 812.4875
261 261 857.5125 812.5125
262 262 857.5375 812.5375
263 263 857.5625 812.5625
264 264 857.5875 812.5875
265 265 857.6125 812.6125

266 266 857.6375 812.6375
267 267 857.6625 812.6625
268 268 857.6875 812.6875
269 269 857.7125 812.7125
270 270 857.7375 812.7375
271 271 857.7625 812.7625
272 272 857.7875 812.7875
273 273 857.8125 812.8125
274 274 857.8375 812.8375
275 275 857.8625 812.8625
276 276 857.8875 812.8875
277 277 857.9125 812.9125
278 278 857.9375 812.9375
279 279 857.9625 812.9625
280 280 857.9875 812.9875
281 281 858.0125 813.0125
282 282 858.0375 813.0375
283 283 858.0625 813.0625
284 284 858.0875 813.0875
285 285 858.1125 813.1125
286 286 858.1375 813.1375
287 287 858.1625 813.1625
288 288 858.1875 813.1875
289 289 858.2125 813.2125
290 290 858.2375 813.2375
291 291 858.2625 813.2625
292 292 858.2875 813.2875
293 293 858.3125 813.3125
294 294 858.3375 813.3375
295 295 858.3625 813.3625
296 296 858.3875 813.3875
297 297 858.4125 813.4125
298 298 858.4375 813.4375
299 299 858.4625 813.4625
300 300 858.4875 813.4875
301 301 858.5125 813.5125
302 302 858.5375 813.5375
303 303 858.5625 813.5625
304 304 858.5875 813.5875
305 305 858.6125 813.6125
306 306 858.6375 813.6375
307 307 858.6625 813.6625
308 308 858.6875 813.6875
309 309 858.7125 813.7125
310 310 858.7375 813.7375
311 311 858.7625 813.7625
312 312 858.7875 813.7875
313 313 858.8125 813.8125
314 314 858.8375 813.8375
315 315 858.8625 813.8625
316 316 858.8875 813.8875
317 317 858.9125 813.9125
318 318 858.9375 813.9375
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319 319 858.9625 813.9625
320 320 858.9875 813.9875
321 321 859.0125 814.0125
322 322 859.0375 814.0375
323 323 859.0625 814.0625
324 324 859.0875 814.0875
325 325 859.1125 814.1125
326 326 859.1375 814.1375
327 327 859.1625 814.1625
328 328 859.1875 814.1875
329 329 859.2125 814.2125
330 330 859.2375 814.2375
331 331 859.2625 814.2625
332 332 859.2875 814.2875
333 333 859.3125 814.3125
334 334 859.3375 814.3375
335 335 859.3625 814.3625
336 336 859.3875 814.3875
337 337 859.4125 814.4125
338 338 859.4375 814.4375
339 339 859.4625 814.4625
340 340 859.4875 814.4875
341 341 859.5125 814.5125
342 342 859.5375 814.5375
343 343 859.5625 814.5625
344 344 859.5875 814.5875
345 345 859.6125 814.6125
346 346 859.6375 814.6375
347 347 859.6625 814.6625
348 348 859.6875 814.6875
349 349 859.7125 814.7125
350 350 859.7375 814.7375
351 351 859.7625 814.7625
352 352 859.7875 814.7875
353 353 859.8125 814.8125
354 354 859.8375 814.8375
355 355 859.8625 814.8625
356 356 859.8875 814.8875
357 357 859.9125 814.9125
358 358 859.9375 814.9375
359 359 859.9625 814.9625
360 360 859.9875 814.9875
361 361 860.0125 815.0125
362 362 860.0375 815.0375
363 363 860.0625 815.0625
364 364 860.0875 815.0875
365 365 860.1125 815.1125
366 366 860.1375 815.1375
367 367 860.1625 815.1625
368 368 860.1875 815.1875
369 369 860.2125 815.2125
370 370 860.2375 815.2375
371 371 860.2625 815.2625

372 372 860.2875 815.2875
373 373 860.3125 815.3125
374 374 860.3375 815.3375
375 375 860.3625 815.3625
376 376 860.3875 815.3875
377 377 860.4125 815.4125
378 378 860.4375 815.4375
379 379 860.4625 815.4625
380 380 860.4875 815.4875
381 381 860.5125 815.5125
382 382 860.5375 815.5375
383 383 860.5625 815.5625
384 384 860.5875 815.5875
385 385 860.6125 815.6125
386 386 860.6375 815.6375
387 387 860.6625 815.6625
388 388 860.6875 815.6875
389 389 860.7125 815.7125
390 390 860.7375 815.7375
391 391 860.7625 815.7625
392 392 860.7875 815.7875
393 393 860.8125 815.8125
394 394 860.8375 815.8375
395 395 860.8625 815.8625
396 396 860.8875 815.8875
397 397 860.9125 815.9125
398 398 860.9375 815.9375
399 399 860.9625 815.9625
400 400 860.9875 815.9875
401 401 861.0125 816.0125
402 402 861.0375 816.0375
403 403 861.0625 816.0625
404 404 861.0875 816.0875
405 405 861.1125 816.1125
406 406 861.1375 816.1375
407 407 861.1625 816.1625
408 408 861.1875 816.1875
409 409 861.2125 816.2125
410 410 861.2375 816.2375
411 411 861.2625 816.2625
412 412 861.2875 816.2875
413 413 861.3125 816.3125
414 414 861.3375 816.3375
415 415 861.3625 816.3625
416 416 861.3875 816.3875
417 417 861.4125 816.4125
418 418 861.4375 816.4375
419 419 861.4625 816.4625
420 420 861.4875 816.4875
421 421 861.5125 816.5125
422 422 861.5375 816.5375
423 423 861.5625 816.5625
424 424 861.5875 816.5875
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425 425 861.6125 816.6125
426 426 861.6375 816.6375
427 427 861.6625 816.6625
428 428 861.6875 816.6875
429 429 861.7125 816.7125
430 430 861.7375 816.7375
431 431 861.7625 816.7625
432 432 861.7875 816.7875
433 433 861.8125 816.8125
434 434 861.8375 816.8375
435 435 861.8625 816.8625
436 436 861.8875 816.8875
437 437 861.9125 816.9125
438 438 861.9375 816.9375
439 439 861.9625 816.9625
440 440 861.9875 816.9875
441 441 862.0125 817.0125
442 442 862.0375 817.0375
443 443 862.0625 817.0625
444 444 862.0875 817.0875
445 445 862.1125 817.1125
446 446 862.1375 817.1375
447 447 862.1625 817.1625
448 448 862.1875 817.1875
449 449 862.2125 817.2125
450 450 862.2375 817.2375
451 451 862.2625 817.2625
452 452 862.2875 817.2875
453 453 862.3125 817.3125
454 454 862.3375 817.3375
455 455 862.3625 817.3625
456 456 862.3875 817.3875
457 457 862.4125 817.4125
458 458 862.4375 817.4375
459 459 862.4625 817.4625
460 460 862.4875 817.4875
461 461 862.5125 817.5125
462 462 862.5375 817.5375
463 463 862.5625 817.5625
464 464 862.5875 817.5875
465 465 862.6125 817.6125
466 466 862.6375 817.6375
467 467 862.6625 817.6625
468 468 862.6875 817.6875
469 469 862.7125 817.7125
470 470 862.7375 817.7375
471 471 862.7625 817.7625
472 472 862.7875 817.7875
473 473 862.8125 817.8125
474 474 862.8375 817.8375
475 475 862.8625 817.8625
476 476 862.8875 817.8875
477 477 862.9125 817.9125

478 478 862.9375 817.9375
479 479 862.9625 817.9625
480 480 862.9875 817.9875
481 481 863.0125 818.0125
482 482 863.0375 818.0375
483 483 863.0625 818.0625
484 484 863.0875 818.0875
485 485 863.1125 818.1125
486 486 863.1375 818.1375
487 487 863.1625 818.1625
488 488 863.1875 818.1875
489 489 863.2125 818.2125
490 490 863.2375 818.2375
491 491 863.2625 818.2625
492 492 863.2875 818.2875
493 493 863.3125 818.3125
494 494 863.3375 818.3375
495 495 863.3625 818.3625
496 496 863.3875 818.3875
497 497 863.4125 818.4125
498 498 863.4375 818.4375
499 499 863.4625 818.4625
500 500 863.4875 818.4875
501 501 863.5125 818.5125
502 502 863.5375 818.5375
503 503 863.5625 818.5625
504 504 863.5875 818.5875
505 505 863.6125 818.6125
506 506 863.6375 818.6375
507 507 863.6625 818.6625
508 508 863.6875 818.6875
509 509 863.7125 818.7125
510 510 863.7375 818.7375
511 511 863.7625 818.7625
512 512 863.7875 818.7875
513 513 863.8125 818.8125
514 514 863.8375 818.8375
515 515 863.8625 818.8625
516 516 863.8875 818.8875
517 517 863.9125 818.9125
518 518 863.9375 818.9375
519 519 863.9625 818.9625
520 520 863.9875 818.9875
521 521 864.0125 819.0125
522 522 864.0375 819.0375
523 523 864.0625 819.0625
524 524 864.0875 819.0875
525 525 864.1125 819.1125
526 526 864.1375 819.1375
527 527 864.1625 819.1625
528 528 864.1875 819.1875
529 529 864.2125 819.2125
530 530 864.2375 819.2375
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531 531 864.2625 819.2625
532 532 864.2875 819.2875
533 533 864.3125 819.3125
534 534 864.3375 819.3375
535 535 864.3625 819.3625
536 536 864.3875 819.3875
537 537 864.4125 819.4125
538 538 864.4375 819.4375
539 539 864.4625 819.4625
540 540 864.4875 819.4875
541 541 864.5125 819.5125
542 542 864.5375 819.5375
543 543 864.5625 819.5625
544 544 864.5875 819.5875
545 545 864.6125 819.6125
546 546 864.6375 819.6375
547 547 864.6625 819.6625
548 548 864.6875 819.6875
549 549 864.7125 819.7125
550 550 864.7375 819.7375
551 551 864.7625 819.7625
552 552 864.7875 819.7875
553 553 864.8125 819.8125
554 554 864.8375 819.8375
555 555 864.8625 819.8625
556 556 864.8875 819.8875
557 557 864.9125 819.9125
558 558 864.9375 819.9375
559 559 864.9625 819.9625
560 560 864.9875 819.9875
561 561 865.0125 820.0125
562 562 865.0375 820.0375
563 563 865.0625 820.0625
564 564 865.0875 820.0875
565 565 865.1125 820.1125
566 566 865.1375 820.1375
567 567 865.1625 820.1625
568 568 865.1875 820.1875
569 569 865.2125 820.2125
570 570 865.2375 820.2375
571 571 865.2625 820.2625
572 572 865.2875 820.2875
573 573 865.3125 820.3125
574 574 865.3375 820.3375
575 575 865.3625 820.3625
576 576 865.3875 820.3875
577 577 865.4125 820.4125
578 578 865.4375 820.4375
579 579 865.4625 820.4625
580 580 865.4875 820.4875
581 581 865.5125 820.5125
582 582 865.5375 820.5375
583 583 865.5625 820.5625

584 584 865.5875 820.5875
585 585 865.6125 820.6125
586 586 865.6375 820.6375
587 587 865.6625 820.6625
588 588 865.6875 820.6875
589 589 865.7125 820.7125
590 590 865.7375 820.7375
591 591 865.7625 820.7625
592 592 865.7875 820.7875
593 593 865.8125 820.8125
594 594 865.8375 820.8375
595 595 865.8625 820.8625
596 596 865.8875 820.8875
597 597 865.9125 820.9125
598 598 865.9375 820.9375
599 599 865.9625 820.9625
600 600 865.9875 820.9875
601 - 866.0000 821.0000
602 601 866.0125 821.0125
603 - 866.0250 821.0250
604 602 866.0375 821.0375
605 603 866.0500 821.0500
606 604 866.0625 821.0625
607 605 866.0750 821.0750
608 606 866.0875 821.0875
609 607 866.1000 821.1000
610 608 866.1125 821.1125
611 609 866.1250 821.1250
612 610 866.1375 821.1375
613 611 866.1500 821.1500
614 612 866.1625 821.1625
615 613 866.1750 821.1750
616 614 866.1875 821.1875
617 615 866.2000 821.2000
618 616 866.2125 821.2125
619 617 866.2250 821.2250
620 618 866.2375 821.2375
621 619 866.2500 821.2500
622 620 866.2625 821.2625
623 621 866.2750 821.2750
624 622 866.2875 821.2875
625 623 866.3000 821.3000
626 624 866.3125 821.3125
627 625 866.3250 821.3250
628 626 866.3375 821.3375
629 627 866.3500 821.3500
630 628 866.3625 821.3625
631 629 866.3750 821.3750
632 630 866.3875 821.3875
633 631 866.4000 821.4000
634 632 866.4125 821.4125
635 633 866.4250 821.4250
636 634 866.4375 821.4375
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637 635 866.4500 821.4500
638 636 866.4625 821.4625
639 637 866.4750 821.4750
640 638 866.4875 821.4875
641 - 866.5000 821.5000
642 639 866.5125 821.5125
643 - 866.5250 821.5250
644 640 866.5375 821.5375
645 641 866.5500 821.5500
646 642 866.5625 821.5625
647 643 866.5750 821.5750
648 644 866.5875 821.5875
649 645 866.6000 821.6000
650 646 866.6125 821.6125
651 647 866.6250 821.6250
652 648 866.6375 821.6375
653 649 866.6500 821.6500
654 650 866.6625 821.6625
655 651 866.6750 821.6750
656 652 866.6875 821.6875
657 653 866.7000 821.7000
658 654 866.7125 821.7125
659 655 866.7250 821.7250
660 656 866.7375 821.7375
661 657 866.7500 821.7500
662 658 866.7625 821.7625
663 659 866.7750 821.7750
664 660 866.7875 821.7875
665 661 866.8000 821.8000
666 662 866.8125 821.8125
667 663 866.8250 821.8250
668 664 866.8375 821.8375
669 665 866.8500 821.8500
670 666 866.8625 821.8625
671 667 866.8750 821.8750
672 668 866.8875 821.8875
673 669 866.9000 821.9000
674 670 866.9125 821.9125
675 671 866.9250 821.9250
676 672 866.9375 821.9375
677 673 866.9500 821.9500
678 674 866.9625 821.9625
679 675 866.9750 821.9750
680 676 866.9875 821.9875
681 - 867.0000 822.0000
682 677 867.0125 822.0125
683 - 867.0250 822.0250
684 678 867.0375 822.0375
685 679 867.0500 822.0500
686 680 867.0625 822.0625
687 681 867.0750 822.0750
688 682 867.0875 822.0875
689 683 867.1000 822.1000

690 684 867.1125 822.1125
691 685 867.1250 822.1250
692 686 867.1375 822.1375
693 687 867.1500 822.1500
694 688 867.1625 822.1625
695 689 867.1750 822.1750
696 690 867.1875 822.1875
697 691 867.2000 822.2000
698 692 867.2125 822.2125
699 693 867.2250 822.2250
700 694 867.2375 822.2375
701 695 867.2500 822.2500
702 696 867.2625 822.2625
703 697 867.2750 822.2750
704 698 867.2875 822.2875
705 699 867.3000 822.3000
706 700 867.3125 822.3125
707 701 867.3250 822.3250
708 702 867.3375 822.3375
709 703 867.3500 822.3500
710 704 867.3625 822.3625
711 705 867.3750 822.3750
712 706 867.3875 822.3875
713 707 867.4000 822.4000
714 708 867.4125 822.4125
715 709 867.4250 822.4250
716 710 867.4375 822.4375
717 711 867.4500 822.4500
718 712 867.4625 822.4625
719 713 867.4750 822.4750
720 714 867.4875 822.4875
721 - 867.5000 822.5000
722 715 867.5125 822.5125
723 - 867.5250 822.5250
724 716 867.5375 822.5375
725 717 867.5500 822.5500
726 718 867.5625 822.5625
727 719 867.5750 822.5750
728 720 867.5875 822.5875
729 721 867.6000 822.6000
730 722 867.6125 822.6125
731 723 867.6250 822.6250
732 724 867.6375 822.6375
733 725 867.6500 822.6500
734 726 867.6625 822.6625
735 727 867.6750 822.6750
736 728 867.6875 822.6875
737 729 867.7000 822.7000
738 730 867.7125 822.7125
739 731 867.7250 822.7250
740 732 867.7375 822.7375
741 733 867.7500 822.7500
742 734 867.7625 822.7625
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743 735 867.7750 822.7750
744 736 867.7875 822.7875
745 737 867.8000 822.8000
746 738 867.8125 822.8125
747 739 867.8250 822.8250
748 740 867.8375 822.8375
749 741 867.8500 822.8500
750 742 867.8625 822.8625
751 743 867.8750 822.8750
752 744 867.8875 822.8875
753 745 867.9000 822.9000
754 746 867.9125 822.9125
755 747 867.9250 822.9250
756 748 867.9375 822.9375
757 749 867.9500 822.9500
758 750 867.9625 822.9625
759 751 867.9750 822.9750
760 752 867.9875 822.9875
761 - 868.0000 823.0000
762 753 868.0125 823.0125
763 - 868.0250 823.0250
764 754 868.0375 823.0375
765 755 868.0500 823.0500
766 756 868.0625 823.0625
767 757 868.0750 823.0750
768 758 868.0875 823.0875
769 759 868.1000 823.1000
770 760 868.1125 823.1125
771 761 868.1250 823.1250
772 762 868.1375 823.1375
773 763 868.1500 823.1500
774 764 868.1625 823.1625
775 765 868.1750 823.1750
776 766 868.1875 823.1875
777 767 868.2000 823.2000
778 768 868.2125 823.2125
779 769 868.2250 823.2250
780 770 868.2375 823.2375
781 771 868.2500 823.2500
782 772 868.2625 823.2625
783 773 868.2750 823.2750
784 774 868.2875 823.2875
785 775 868.3000 823.3000
786 776 868.3125 823.3125
787 777 868.3250 823.3250
788 778 868.3375 823.3375
789 779 868.3500 823.3500
790 780 868.3625 823.3625
791 781 868.3750 823.3750
792 782 868.3875 823.3875
793 783 868.4000 823.4000
794 784 868.4125 823.4125
795 785 868.4250 823.4250

796 786 868.4375 823.4375
797 787 868.4500 823.4500
798 788 868.4625 823.4625
799 789 868.4750 823.4750
800 790 868.4875 823.4875
801 791 868.5000 823.5000
802 792 868.5125 823.5125
803 793 868.5250 823.5250
804 794 868.5375 823.5375
805 795 868.5500 823.5500
806 796 868.5625 823.5625
807 797 868.5750 823.5750
808 798 868.5875 823.5875
809 799 868.6000 823.6000
810 800 868.6125 823.6125
811 801 868.6250 823.6250
812 802 868.6375 823.6375
813 803 868.6500 823.6500
814 804 868.6625 823.6625
815 805 868.6750 823.6750
816 806 868.6875 823.6875
817 807 868.7000 823.7000
818 808 868.7125 823.7125
819 809 868.7250 823.7250
820 810 868.7375 823.7375
821 811 868.7500 823.7500
822 812 868.7625 823.7625
823 813 868.7750 823.7750
824 814 868.7875 823.7875
825 815 868.8000 823.8000
826 816 868.8125 823.8125
827 817 868.8250 823.8250
828 818 868.8375 823.8375
829 819 868.8500 823.8500
830 820 868.8625 823.8625
831 821 868.8750 823.8750
832 822 868.8875 823.8875
833 823 868.9000 823.9000
834 824 868.9125 823.9125
835 825 868.9250 823.9250
836 826 868.9375 823.9375
837 827 868.9500 823.9500
838 828 868.9625 823.9625
839 829 868.9750 823.9750
840 830 868.9875 823.9875
841 - 869.0000 824.0000
842 - 869.0125 824.0125
843 - 869.0250 824.0250
844 - 869.0375 824.0375
845 - 869.0500 824.0500
846 - 869.0625 824.0625
847 - 869.0750 824.0750
848 - 869.0875 824.0875
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849 - 869.1000 824.1000
850 - 869.1125 824.1125
851 - 869.1250 824.1250
852 - 869.1375 824.1375
853 - 869.1500 824.1500
854 - 869.1625 824.1625
855 - 869.1750 824.1750
856 - 869.1875 824.1875
857 - 869.2000 824.2000
858 - 869.2125 824.2125
859 - 869.2250 824.2250
860 - 869.2375 824.2375
861 - 869.2500 824.2500
862 - 869.2625 824.2625
863 - 869.2750 824.2750
864 - 869.2875 824.2875
865 - 869.3000 824.3000
866 - 869.3125 824.3125
867 - 869.3250 824.3250
868 - 869.3375 824.3375
869 - 869.3500 824.3500
870 - 869.3625 824.3625
871 - 869.3750 824.3750
872 - 869.3875 824.3875
873 - 869.4000 824.4000
874 - 869.4125 824.4125
875 - 869.4250 824.4250
876 - 869.4375 824.4375
877 - 869.4500 824.4500
878 - 869.4625 824.4625
879 - 869.4750 824.4750
880 - 869.4875 824.4875
881 - 869.5000 824.5000
882 - 869.5125 824.5125
883 - 869.5250 824.5250
884 - 869.5375 824.5375

885 - 869.5500 824.5500
886 - 869.5625 824.5625
887 - 869.5750 824.5750
888 - 869.5875 824.5875
889 - 869.6000 824.6000
890 - 869.6125 824.6125
891 - 869.6250 824.6250
892 - 869.6375 824.6375
893 - 869.6500 824.6500
894 - 869.6625 824.6625
895 - 869.6750 824.6750
896 - 869.6875 824.6875
897 - 869.7000 824.7000
898 - 869.7125 824.7125
899 - 869.7250 824.7250
900 - 869.7375 824.7375
901 - 869.7500 824.7500
902 - 869.7625 824.7625
903 - 869.7750 824.7750
904 - 869.7875 824.7875
905 - 869.8000 824.8000
906 - 869.8125 824.8125
907 - 869.8250 824.8250
908 - 869.8375 824.8375
909 - 869.8500 824.8500
910 - 869.8625 824.8625
911 - 869.8750 824.8750
912 - 869.8875 824.8875
913 - 869.9000 824.9000
914 - 869.9125 824.9125
915 - 869.9250 824.9250
916 - 869.9375 824.9375
917 - 869.9500 824.9500
918 - 869.9625 824.9625
919 - 869.9750 824.9750
920 - 869.9875 824.9875
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INDEX

INDEX

Numerics
51xx/Ascend Portable Programming 

Setup 4
53xx/Ascend Mobile Programming 

Setup 5
800 MHz Channel Table 38

A
Add System 12
Alternating Display 28
Anti-Cloning Safeguards 37
Ascend Radios 5
Auto-Registration 29
Auxiliary B 24
Auxiliary B Input 24

B
Backlight During Keypad Lockout 22
Backlight Level 23
Backlight on Keypress 22
Backlight On Time 22
Band 17
Battery Saver 21
Baud Rates 12
Block Decode IDs 33

C
Call Delay 28
Call Indicator 35
Call Timer 31
Channel Alias 34
Channel Selector Enabled 23
Channel Setup 30
Channel Type 34
Close 11
Comports 12
Computer Description 5
Computer Requirements 5
Controller Type 23
Convert Band 11
Creating Systems 7
Cursor 21
Custom Tools 17

D
D/H Box 18
Decimal/Hexadecimal Select 7
Delete System 12
Disable PTT Queuing 28
Display Options 28
Dynamic Group Assignment 33

E
Emergency (Conventional) 31
Emergency Alarm 31
Emergency Man Down 24
Encryption Key ID 31
Exit 11
Exiting Program 6
External PA Display 24

F
File 17
File Menu 11
File Size Indication 7
Fixed Priority 33
Frequency Designation 33
Front Keypad Lockout Only 22
Function Button Programming 27
Function Buttons 27

G
Global Emergency Channel 21
Global Screen 7, 20
GPS feature 24
Group Scan List 33
Group Scan Programming 8

H
Handheld Control Unit (HHC) 5
Hang-Up Box Monitor 22
Help 6, 17
Home Channel 20
Home Zone 20
Horn Cadence 21
Horn Indicator 35

I
Ignition Power Down 21
Ignore Clear/Secure 23
Individual ID 31
Information 18
Interconnect Priority/Preemption 33

K
Key 32
Keypad 21
Keypad Type 22
Kill Setting 29

L
LED Disabled 23
LED Indicator 21
Load System Keys 12

Lock Channel Selector 22
Lock Volume Knob 22
Lost Passwords 35
Low Battery Beep 21
Low Battery Indicators 21
Low Power 21

M
Main Screens 7
Man Down 24
Manual

Operation 5
Service 5

Menu Enabled 23
Menu Function Table 28
Menu Items 27
Mic Levels 22
Microphone Jack 5
Minimum Volume 22

N
New 11
Normal/Silent 32

O
On Exit 16
On New 16
Open 11
Option Switch Function Table 28
Organization Identity 14
Organizer 7, 18

P
P25 PTT ID 28
P25 Talk Group on Rx 28
Password

Changing 15, 36
Download/Upload 15, 35, 36
Management 15
Master 15, 35, 36
Power On 35, 36
User 15, 36
Zone 36

Password Operation 35
Penalty Timer 33
Per System Screen 7
Permanent Keypad Lockout 22
Phone Interconnect 33
Phone List 26
Power Up Channel 21
Power Up In 20, 21
Power Up Zone 20
Preferences 16



INDEX

48

Print 11
Priority Lookback Time A 31
Priority Lookback Time B 31
Proceed Tone 35
Programmable Title and Logo 7
Programmed Channels Only on 

Display 22
Programming Cable 4
Programming Procedure 9
Programming Setup 4
PTT Tone Delay 35

R
Radio Menu 11
Radio Wide Conventional 

Parameters 26
Radio Wide Lists 26
Radio Wide Scan Programming 8
Radio Wide Screen 7
Radio-Wide Scan List 25
rcf 6
Read Options From Radio 14
Read Parameters From Radio 12
Read Version Info From Radio 13
Read/Write IP Address 14
Read/Write Spur Frequencies 14
Receive

Group ID 35
Receive Delay 28
Release Notes 6
Remember Band 16
Remember Baud Rate 16
Remember Keys Directory 16
Remember Series 16
Remote Programming Interface 

(RPI) 5
RSSI 31
RSSI Threshold 26
Rx Audio to External PA 24

Rx Preemption 34

S
Save 11
Save As 11
Scan Delay Timers 28
Scan Hold Time 26
Scan Programming 8
Scan Talk Back Type 25
Selected User 15
Send to Selected Organizer Group 11
Serial Communication 16
Series 11, 17
Setting Up Channels 30
Setting Up Zones 29
Site Alias 32
Site List 32
Size 18
Soft Power Down 21
Software Installation 5
Software Versions 5
Sound 21
Splinter Channels 32
Standard Tools 17
Status Bar 17
Status Channel Number 32
Status Message List 26
Surveillance Mode 23
System Access Queuing 29
System Lists 32
System, Creating 7

T
Talk Permit Tone 35
Talkback Scan 29
Time-Out Timer 33
Timers 33
Tone On/Off 21

Tone Volume 22
Toolbar 17
Toolbar Options 14
Tools Menu 14
Transfer Menu 12
Transfer Tools 17
Transmit 34

Disabled 34
Group ID 34
Priority 35

Transmit Inhibit IDs 33
Transmit Power 34
Tx Chirp 21
Tx Priority 33

U
Unique ID 31
Unit Call 33
Unit Call List 26
Unit Call Priority/Preemption 34
Use Hexadecimal Input 16
User x 15

V
View Programmed Radio Wide 

Functions 12
Volume Ticks 23

W
Write Application Code to Radio 13
Write DSP Code To Radio 12
Write Parameters To Radio 12

Z
Zone Password 36
Zone Screen 7
Zone Setup 29
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